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SCOPE

This document covers Test Application Software (TSAP) installed in the HFC-6000
controller Test Specimen during qualification testing. The Test Specimen will be a
modular, fully functional control system composed of a single redundant remote, I/O
modules, and ancillary equipment.

2.0 PURPOSE

The TSAP will operate as an application program of the main processor on the controller
card. It will accept operator inputs from control switch modules (CSM), M/A stations, a
flat panel display (FPD), and a JCRT PC workstation. It will include both control logic
for simulated functional control loops and support for prudency and operability tests that
are designed to exercise control system logic functions. The TSAP will use data inputs
from configured AI and DI channels to update values for AO and DO points as well as
alarm status. The TSAP retrieves all input data from memory on the HFC-SBC06
controller and transfers all output values to memory during each processing cycle.
Utilities for running the I/O scan and transferring status to appropriate displays are
external to the TSAP.

3.0 REFERENCES

3.1 RELATED PUBLICATIONS

EPRI TR-107330 Generic Requirements Specification for Qualifying a
Commercially Available PLC for safety-Related Applications in Nuclear Power Plants

700901-01 HFC-6000 Product Line Specification
TN0401 Master Test Plan
TP0402 Operability Test Procedure
TP0403 Prudency Test Procedure

3.2 TERMS AND ACRONYMS

Al Analog Input
AO Analog Output
CSM Control Switch Module
DI Digital Input
DO Digital Output
EWS Engineering Workstation
FL Flag
HPAT HFC Plant Automated Tester
I/O Input/Output
JCRT Java CRT Workstation
M/A Manual/Automatic
MS Message
TI Timer
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4.0 FUNCTIONAL ANALYSIS

The following paragraphs define the functional requirements of the TSAP to be installed
in the HFC-6000 Test Specimen.

4.1 GENERAL REQUIREMENTS

[

7.

I
4.2 INPUT REQUIREMENTS

The following inputs correspond to the Al, DI, and pulse input signals, which will be
generated by the HPAT hardware. Most input channels used for operability and
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prudency testing will be connected directly to corresponding output points without
intermediate gating. Inputs for the simulated control loops will be connected to the logic
algorithms for those loops.

5.

]
4.3 PROCESSING REQUIREMENTS

The TSAP will provide logic to perform the following functions.

* Read inputs associated with the operability and prudency tests.
* Drive outputs required by the operability and prudency tests.
* Provide logic for timer testing.
* Provide algorithms for the simulated control loops.
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The following paragraphs provide a detailed list of requirements to ensure adequate
support for the prudency and operability tests.

4.3.1 Accuracy Test Support

Refer to TP0402 for a detailed description of accuracy testing run as part of the
operability group of tests. The following are the specific test support requirements for
the TSAP.

Figure 1. Analog Accuracy Test Waveform
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4.3.2 Response Time Tests

The TSAP shall provide separate algorithms to support both digital and analog response
time measurements. Refer to TP0402 paragraph 3.3.3 for detailed information about the
operability response time tests.

[

2.

I

Figure 2. Digital Response Time Test Algorithm

Figure 3. Analog Response Time Test Algorithm
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4.3.3 Discrete Operabilitv Tests

No special logic support will be required for the discrete input and discrete output
operability tests. (Refer to TP0402 paragraphs 3.3.4 and 3.3.5.)

4.3.4 Timer Test

The TSAP shall provide the algorithm required to support the operability timer test.
Refer to TP0402 paragraph 3.3.7 for detailed information about the timer test.

[

2.

I

Figure 4. Timer Test Algorithni

4.3.5 Prudencv Burst of Events Test

The prudency burst of events test exercises a significant number of channels
simultaneously. The external HPAT controls the Al and DI signals supplied to the input
interface of the Test Specimen, and the TSAP provides analog and digital algorithms to
control the corresponding output channels.

[

3.

I
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Figure 5. TSAP DO Control Algorithm for Burst of Events

4.3.6 Heartbeat Monitor

The TSAP shall contain a dedicated counter configured to increment by one count during
each execution cycle of the equation interpreter. This counter will provide a direct
indication that the controller is executing the application code.

4.3.7 Simulated Control Loops

The TSAP will provide logic for a minimum of 10 (five analog and five digital)
simulated control loops. Each control loop will receive simulated inputs from the HPAT
and execute a control algorithm appropriate for the simulated field device under control.
The resulting outputs will control output signals to the simulated process as well as status
and alarm signals. Minimum requirements for the simulated control loops are as follows.

[

10 of 12



HFC-6000 Product Line
Test Application Software

700901-09
Rev A

7.
I

4.4 OUTPUT REQUIREMENTS

The following outputs correspond to the AO and DO signals, which will be generated by
the TSAP. Most output channels used for operability and prudency testing will be
connected directly to corresponding input points of the HPAT for logging purposes.
Output signals for the simulated control loops will be connected to the simulation
algorithms in the HPAT for field devices or processes.

4.

4.5 CONCEPTUAL MODULE DESCRIPTION

I

4.6 ASSUMPTIONS

The design requirements for the TSAP of the Test Specimen is based on the following
assumptions:
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II

0

I

4.7 CRITICAL ISSUES

None
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER:

REVISION: A

CGSE002

Safety Related: [X]YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION: HFC-SBC06 Main Processor System Firmware

SOFTWARE NUMBER: 9120905-10 Rev: CKSM 147C

Assigned Engineer: Jonathan Taylor Date:- 12/15/05

Technical Reviewer: Steve Yang Date:- 12/15/05

Approved By7" A11-n P-e"1 Date: 12 / 15/05

V & V Review: Bob Cain Date: 12/15/05
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software PIN: 9120905-10
CGS CLASSIFICATION SHEET

CGSEOO2, Rev A
Rev: CKSM 147C Description: Main Processor Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Main processor initialization.

Overall status monitoring and control.

Runs system application code.

Primary executes status drop to secondary controller.

Secondary receives status drop from primary.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error produces invalid data image.

Program error disables required function.
Heavy loading results in failure to execute utility task.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing: their intended
safety function?

Incorrect program branching without processor stall could prevent the
safety system from performing its intended function.
Generation of invalid data image could result in incorrect or
unexpected control of an output channel.
Secondary processor stall without failover could disable the
corresponding portion of the safety system.

QPP 7.3 Page 2 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120905-10
CGS CLASSIFICATION SHEET

CGSE002, Rev A
Rev: CKSM 147C Description: Main Processor Firmware

Yes [X] (Item has safety function)

No [ (Item has non-safety function)

Method (Mark all that apply)

A "YES" in all three criteria is required for the item to be classified
commercial grade.

as

YES NO

1 Is the item not subject to design or specification
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the
basis of specifications set forth in the manufacturer's
published description?

lXI

[XJ

[XI

[1

[I

[I

Commercial Grade Software Item

PHYSICAL CRITICAL CHARACTERISTICS:

IXN [I

Source code files

Compiled object code designation

Module checksum generated during compilation and when PROM is encoded.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120905-10
CGS CLASSIFICATION SHEET

CGSE002, Rev A
Rev: CKSM 147C Description: Main Processor Firmware

PERFORMANCE CRITICAL CHARACTERISTICS:

Initialization control

System status monitoring and display

Hardware watchdog control function
I
Application functional processing

[I

Performance under heavy loading conditions

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration management

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[X] Method 1 - Special Tests and Inspections.

[X] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X] Method 4 - Historical Performance Records.

QPP 7.3 Page 4 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120905-10 Description: SC Firmware CGSE 002 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification

CC#001 Source files are controlled with limited Direct examination of source files
Source code files access.

Source code review documentation
Revision record is included in the
header of each source file. Source code test reports

Source code reviews generated for Prototype test report
critical source code files.

Module-level test of PDS files.
CC#002 Object code file designated as Direct verification
Compiled object code designation 912090510.hex
CC#003 One byte compiler checksum value Checksum 147C is based on the SC
Module checksum and PROM part (32H) is inserted as the first byte of program code with a generic database
number the object code header. configuration. Changing the database

size will result in a different checksum
Two byte object code checksum value and a different part number.
(147CH) calculated at the time the
PROM is programmed. Physical verification of U52 label on

assembly.
Checksum value and PROM part
number are printed on a label, and Direct verification of one-byte
that label is affixed to the outside of checksum value from PROM header.
the PROM.

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review.
Initialization control specification to verify operability

status Source code test reports
QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120905-10 Description: SC Firmware CGSE 002 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#005 Detects any failure during initializa- Prototype test report
System status monitoring and display tion sequence and displays failure

code UG004-000-08

Detects run-time failure and displays
failure code.

Displays tasking code throughout
normal operation.

CC#006 Per design specification, as revised for TS901-000-42
Hardware/software watchdog control 0.5 second failover.
function TR901-000-02
CC#007 Per design specification. Source code review.
Support for redundant controller Source code test reports
configuration Functional test.
CC#008 Supports standard Boolean functions Application Objects Test Report
Support for application processing Supports programmable timer

function TROO 1-000-02
Supports block algorithms for analog
processing DS001-000-003

CC#009 Per design specification. Prototype test report

CC#010 Per design specification. Prototype test report[

QPP 7.3 Page 6 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120905-10 Description: SC Firmware CGSE 002 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#O 11 [
Performance under abnormal loading
conditions
Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#012 NQA1 QA program Records of internal and external
Built-in quality audits

Source code review records
Source code test reports
Prototype test report

CC#013 Source files are retained in CMS Direct inspection
Configuration control library with limited access; current

object file is retained in the assembly
release directory and matches BOM _

CC#014 Revision record in file header Direct inspection of source files
Operating history indicates up to 20 years operating CR and SCR database

history, including the past several Cumulative operating history of
years an Ulchin NPP. generic operating system

CC#015 Corrective action program in place QPP 16.1 and CR/SCR database
Reporting and problem resolution and being used for evaluating and Record of reported errors for generic

resolving reported problems. operating system
T-FC' suppr ts-wwt R P---+ 2l. 1 reotn U~)),, ~. A'~%ALL~ ~ IU.P.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120905-10 -Description: SC Firmware CGSE 002 Rev: A

M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition
CR#
CR#
CR#
Other:

Report (CR): [ ] Yes[ ] No [ I N/A
[ ]Acceptable [ ] Not Acceptable
[ ]Acceptable [ ] Not Acceptable
[ ]Acceptable [ ] Not Acceptable

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120905-10 D~escription:. SC Firmware CGSE 002 Rev: A

Sheet of
CC# P/F/N Preformed By Date Verified By Date
001
002
003
004
004
006
007
008
009
010
011
012
013
014
015
P = Pass, F = Fail, N = Not Applicable

Characteristics Record Sheet Competition:

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A

Page 9 of 9



-0

ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER: CGSE004

REVISION: A

Safety Related: [ ] YES [X] NO

MANUFACTURER: HF Controls

DESCRIPTION: HFC-SBC06 SEP System Firmware

SOFTWARE NUMBER: 9120907-11 Rev: CKSM 6FF8

Assigned Engineer:

Technical Reviewer:

Approved By:

V & V Review:

Jonathan Taylor

Steve Yang

Allen Hsu

Bob Cain

Date:. 12/15/05

Date: 12/16/05

Date:- 12/16/05

Date:- 12/16/05
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120907-11
CGS CLASSIFICATION SHEET

CGSE004, Rev A
Rev: CKSM 6FF8 Description: SEP Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

SEP processor initialization.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.
Program error results in communication error.

Program error results in corruption of data.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

No. C-Link is used for transfer of status data only.

QPP 7.3 Page 2 of 6
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120907-11
CGS CLASSIFICATION SHEET

CGSE004, Rev A
Rev: CKSM 6FF8 Description: SEP Firmware

Yes [ ] (Item has safety function)

No [X] (Item has non-safety function)

Method (Mark all that apply}

A "YES" in all three criteria is required for the item to
commercial grade.

be classified as

YES NO

[Xl 111 Is the item not subject to design or specification
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the
basis of specifications set forth in the manufacturer's
published description?

1X]

[Xl

1]

[1

Commercial Grade Software Item

QPP 7.3 Page 3 of 6
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120907-11
CGS CLASSIFICATION SHEET

CGSE004, Rev A
Rev: CKSM 6FF8 Description: SEP Firmware

PHYSICAL CRITICAL CHARACTERISTICS:

N/A

PERFORMANCE CRITICAL CHARACTERISTICS:

N/A

DEPENDABILITY CRITICAL CHARACTERISTICS:

N/A

METHOD (MARK ALL THAT APPLY):

[ ] Method 1 - Special Tests and Inspections.

I ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[ ] Method 4 - Historical Performance Records.

QPP 7.3 Page 4 of 6
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

9120907-11 Description: SEP Firmware CGSE 004 Rev: A

Characteristic I Acceptance Criteria I Method of Verification

Software P/N:

ATTACHMENT 7.1
CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120907-11 Description: SEP Firmware CGSE 004 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
N/A

ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120907-11 Description: SEP Firmware CGSE 004 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
N/A

QPP 7.3 Page 5 of 6
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120907-11 Description: SEP Firmware C

Record all M&TE used for this test:

:GSE 004 Rev: A

M&TE CIN# I M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. I Cal. Due Date

Condition Report (CR): [ ] Yes [ ] No [ ] N/A If yes, identify below:
CR# [ ]Acceptable [ ] Not Acceptable Initials/Date:
CR# [ ]Acceptable [ ] Not Acceptable Initials/Date:
CR# [ ]Acceptable[ ] Not Acceptable Initials/Date:
Other:

ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

Software P/N: 9120907-11 Description: SEP Firmware CGSE 004 Rev A

Sheet of
N

P = Pass, F = Fail, N =Not Applicable

Characteristics Record Sheet Competition:

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

';ýEVALUATION NUMBER: CGSE006

- REVISION: A

Safetýy:R61atid: [Y] YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION: Y-HFC-AI4K Firmware

SOFTWARE NUMBER: 9120683-12, Rev: CKSM 3B01

Assigned Engineer: Jonathan Taylor LDate: 12/15/05

Technical Reviewer: Steve Yang PDate: 12/16/05

Approved By: Allen Hsu Date: 12'X1105

V & V Review: Bob Cain Date: 12/16105'

Page 1 of 9



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120683-12
CGS CLASSIFICATION SHEET

CGSE006, Rev A
Rev: CKSM 3B01 Description: HFC-AI4K Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of 4-channel pulse input module.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error results in corruption of data images.

Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Corruption of input image (either accumulated count or rate value)
results in invalid control of field process.
Loss of communication with controller or loss of image data prevents
reliable control of field process.

Yes [ X ] (Item has safety function)

No [ I (Item has non-safety function)

QPP 7.3 Page 2 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120683-12
CGS CLASSIFICATION SHEET

CGSE006, Rev A

Rev: CKSM 3B01 Description: HFC-AI4K Firmware

Method (Mark all that apply)

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

1 Is the item not subject to design or specification [X] []
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or [X] []
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the [Xi ]
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item [XI I I

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files

Compiled object code designation

Module checksum generated at the time that the PROM is encoded.

PERFORMANCE CRITICAL CHARACTERISTICS:
Initialization control

Internal status monitoring

Saves pulse channel configuration parameters in non-volatile RAM.

Hardware watchdog strobe function

Input scan cycle control

Input count value processing

Response to messages from the HFC-6000 controller.

QPP 7.3 Page 3 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120683-12
CGS CLASSIFICATION SHEET

CGSE006, Rev A
Rev: CKSM 3B01 Description: HFC-AI4K Firmware

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[ X ] Method 1 - Special Tests and Inspections.

[ X ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120683-12 Description: HFC-AI4K Firmware CGSE 006 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification
CC#001 [ Direct examination of source files
Source Code Files

Source code review documentation
Revision record is included in the
header section of each source code
file.

Source code files are under configura-
tion control.

Source code reviews generated for
critical source code files.

CC#002 . .Object code file is designated Direct verification
Compiled object code designation 912068312.hex.
CC#003 Two-byte checksum (3B01) calculated Checksum 3B01 is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U9.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3 Page 5 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120683-12 -Description: HFC-AI4K Firmware CGSE 006 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability.

Prototype test report
CC#005 Maintains count of communication Source code review
Internal status monitoring function errors.

Prototype test report
Verifies that valid configuration data
is available.

Detects loss of ICL communication
and enables hunt mode.

CC#006 Per design specification and Source code review
Saves pulse channel configuration maintenance manual documentation.
data in non-volatile RAM Prototype test report
CC#007 Per design specification and Source code review
Controls watchdog strobe maintenance manual documentation.

Prototype test report
CC#008 Per design specification Source code review
Input scan function

Prototype test report
CC#009 Processing algorithm uses configura- Source code review
Input count value processing function tion parameters to produce rate or

count value image per design Prototype test report
specification

CC#010 Per design specification and Source code reviewICL response function maintenance manual documentation.

Prototype test report

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120683-12 Description: HFC-AI4K Firmware CGSE 006 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#O11 NQA1 QA Program Records of internal and external
Built-in quality audits,

Software review records.

Prototype test records.
CC#012 Direct inspection
Configuration control

CC#013 Header in source files provide revision Direct inspection
Operating history record; software used for more than 2

years at Ulchin NPP.
CC#014 Corrective action process is in place QPP 16.1 and CR/SCR database
Problem reporting and resolution and being used for evaluating and

resolving reported problems. QPP 16.3

HFC supports CFR Part 21 reporting.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120683-12 Description: HFC-AI4K Firmware CGSE 006 Rev: A
Record all M&TE used for this test:

M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition Report (CR): [ ] Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
Other:

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

Software P/N: 9120683-12 Description: HFC-AI4K Firmware CGSE 006 Rev: A
Sheet of

CC# P/F/N Performed By Date Verified By Date
001
002
003

004
005
006
007
008
009
010
Oil
012
013
014

P = Pass, F =Fail, N =Not Applicable

C.h~aracteri -S4% .i.Co ls-....R. C, Crd .. ,,.q_.,e.t _ _om .*itin...

Verified By
Date:_

QPP 7.3
Revision A

Approved By
Date:
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER: CGSE008

REVISION: A

Safety Related: [Y ] YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION: HFC-AO8F Firmware

SOFTWARE NUMBER: 9120679-16 Rev: CKSM 87C6

Assigned Engineer:

Technical Reviewer:

Approved By:_

V & V Review:

Jonathan Taylor

Steve Yang

Allen Hsu

Bob Cain

Date: 12/15/05

Date: 12/15/05

Date: 12/15/05

Date: 12/16/05
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120679-16
CGS CLASSIFICATION SHEET

CGSE008, Rev A
Rev: CKSM 87C6 Description: HFC-AO8F Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of 8-channel 4- to 20-mA analog output
module.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error prevents transfer of image data to output channel.

Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Failure to update one or more AO channels disables control of field
process.
Loss of communication with controller or loss of image data prevents
reliable control of field process.

Yes [X ] (Item has safety function)

No [ ] (Item has non-safety function)

QPP 7.3 Page 2 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120679-16
CGS CLASSIFICATION SHEET

CGSE008, Rev A
Rev: CKSM 87C6 Description: HFC-AO8F Firmware

Method (Mark all that apply}

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

XiI [I1 Is the item not subject to design or specification
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item

[XI [I

[X1 [I

[X] II

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files

Compiled object code designation

Module checksum generated at the time that the PROM is encoded.

PERFORMANCE CRITICAL CHARACTERISTICS:

Initialization control

Internal status monitoring

Responds to messages from the HFC-6000 controller.

Controls AO scan function.

Hardware watchdog strobe function

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120679-16
CGS CLASSIFICATION SHEET

CGSE008, Rev A
Rev: CKSM 87C6 Description: HFC-AO8F Firmware

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[ X ] Method 1 - Special Tests and Inspections.

[ X ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3 Page 4 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120679-16 Description: HFC-AO8F Firmware CGSE 008 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification

CC#001 [ Direct examination of source file
Source Code Files

Source code review documentation
Revision record is included in the
header section of each source code
file.

Source code files are under configura-
tion control.

Source code reviews generated for
critical source code files.

CC#002 Object code file is designated Direct verification
Compiled object code designation 912067916.hex.
CC#003 Two-byte checksum (87C6) calculated Checksum 87C6 is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U5.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

p79-16 Description: HFC-AO8F Firmware CGSE 008 Rev: ASoftware P/N: 9120E

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability.

Prototype test report
CC#005 Maintains count of communication Source code review
Internal status monitoring errors.

Prototype test report
Records module failsafe configuration.

CC#006 Responds to defined ICL messages per Source code review
ICL response function design specification.

Prototype test report
CC#007 Per design specification Source code review
Controls AO scan function

Prototype test report
CC#008 Per design specification Source code review
Controls watchdog strobe

Prototype test report

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120679-16 Description: HFC-AO8F Firmware CGSE 008 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#009 NQA1 QA Program Records of internal and external
Built-in quality audits.

Software review records.

Prototype test records.
CC#010 Source files are retained in source Direct inspection
Configuration control save; current object file retained in the

assembly release directory and
matches BOM

CC#011 Revision record in file header Direct inspection
Operating History indicates up to 15 years operating

history; including CR and SCR database
CC#012 Corrective action process is in place QPP 16.1 and CR/SCR database
Problem reporting and resolution and being used for evaluating and

resolving reported problems QPP 16.3

HFC supports CFR part 21 reporting

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120679-16 -Description: HFC-AO8F Firmware CGSE 008 Rev: A
Record all M&TE used for this test:

M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

4 4 + *4- 4

4 4 4 4 4-

4 4 4 4 +

4 4 4 4 4

+ 4 4 4

___ I ___ ___ ___ ___ ___

Condition Report (CR): [ ] Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
Other:

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

9120679-16 Description: HFC-AO8F Firmware CGSE 008 Rev: A
Sheet

Software P/N:

of
CC# P/F/N Performed By Date Verified By Date
001
002
003
004
005
006
007

008
009
010
011
012

P = Pass, F = Fail, N Not Applicable

~~~~~~~~~ Id 4~t4 ~~~~ ~-..ZC4LZn

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER: CGSE010

: •REVISION: A

Safety Related: [Y] YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION:- .4HFC-DC34 Firmware

SOFTWARE NUMBER: 9120678-144, Rev: CKSM 2164

Assigned Engineer: Jonathan Taylor )"Date: 12/ 15/05

Technical Reviewer: Steve Yang [Date: 12/16/05

t

Approved By: Allen Hsu Date: 12/16/05

V & V Review: Bob Cain Date: 12/167.05ý
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120678-14
CGS CLASSIFICATION SHEET

CGSEO10, Rev A
Rev: CKSM 2164 Description: HFC-DC34 Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of 12-channel DI, 2-channel 125-vdc DO
module with coil continuity monitoring.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error prevents transfer of image data to output channels or
corrupts DI image.
Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Failure to update DO channels prevents reilable control of field
process.
Loss of DI data prevents reliable status monitoring of field process.

Loss of communication with controller or loss of image data prevents
reliable control of field process.

Yes [X ] (Item has safety function)

No [ (Item has non-safety function)

QPP 7.3 Page 2 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120678-14
CGS CLASSIFICATION SHEET

CGSE010, Rev A

Rev: CKSM 2164 Description: HFC-DC34 Firmware

Method (Mark all that apply)

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

1 Is the item not subject to design or specification [XI [I
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or [XJ []
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the [XI [1
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item [XI [

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files
Compiled object code designation
Module checksum generated at the time that the PROM is encoded.

PERFORMANCE CRITICAL CHARACTERISTICS:

Initialization control
Internal status monitoring

Responds to messages from the HFC-6000 controller.
Controls digital I/O scan function.
Hardware watchdog strobe function

QPP 7.3 Page 3 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120678-14
CGS CLASSIFICATION SHEET

CGSEO10, Rev A
Rev: CKSM 2164 Description: HFC-DC34 Firmware

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[ X ] Method 1 - Special Tests and Inspections.

[ X ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3 Page 4 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120678-14 .Description: HFC-DC34 Firmware CGSE 010 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification
CC#O01 [ Direct examination of source files
Source Code Files

Source code review documentation
Revision record is included in the
header section of each source file.

Source files are under configuration
control.

Source code reviews generated for
critical source code files.

CC#002 Object code file is designated Direct verification
Compiled object code designation 912067614.hex.
CC#003 Two-byte checksum (2C30) calculated Checksum 2C30 is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U8.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120678-14 Description: HFC-DC34 Firmware CGSE 010 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability.

Prototype test report
CC#005 Monitors excitation voltage status, Source code review
Monitors overall hardware status 125 vdc status, and coil continuity

status. Prototype test report

Maintains count of communication
errors.

[

CC#006 Per design specification Source code review
Controls I/O scan function

Prototype test report
CC#007 Responds to defined ICL messages per Source code review
ICL response function design specification.

Prototype test report
CC#008 Per design specification Source code review
Controls watchdog strobe

Prototype test report

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120678-14 Description: HFC-DC34 Firmware CGSE 010 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#009 NQA1 QA Program Records of internal and external
Built-in quality audits.

Software review records.

Prototype test records.
CC#010 Direct inspection
Configuration control

CC#O11 Revision record in source files indicate Direct inspection
Operating history that all components have more than 4

years operating history, including the CR and SCR database
past several years at Ulchin NPP

CC#012 Corrective action process is in place QPP 16.1 and CR/SCR database
Problem reporting and resolution and being used for evaluating and

resolving reported problems. QPP 16.3

HFC supports CFR Part 21 reporting. _

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120678-14 Description: HFC-DC34 Firmware CGSE 010 Rev: A

Record all M&TE used for this test:
M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition Report (CR): [ I Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
Other:

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

9120678-14 Description: HFC-DC34 Firmware CGSE 010 Rev: A
Sheet

Software P/N:
of

CC# P/F/N Performed By Date Verified By Date
001
002
003
004
005
006
007
008
009
010
011 _ _ _ _

012

P = Pass, F = Fail, N = Not Applicable

Characteries~ti~c~s ]Record SheetVI %0mpeitio n

Verified By
Date:

QPP 7.3
Revision A

Approved By
Date:
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER: CGSE012'

REVISION: A

Safety Related: [Y ] YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION: HFC-DO8J Firmware

SOFTWARE NUMBER: 9120677-14 Rev: CKSM AD95

Assigned Engineer:

Technical Reviewer:

Approved By:

V & V Review:

Jonathan Taylor

Steve Yang

Allen Hsu

Bob Cain

Date: 12/15/05

Date: 12/15/05

Date: 12/15/05

Date: 12/16/05
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120677-14
CGS CLASSIFICATION SHEET

CGSE012, Rev A
Rev: CKSM AD95 Description: HFC-DOSJ Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of 8-channel DO module.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error corrupts DO image or prevents transfer of image to
output channel.
Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Loss or corruption of DO control prevents automated control of field
process.

Yes [X (Item has safety function)

No [ ] (Item has non-safety function)

QPP 7.3 Page 2 of 8
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120677-14
CGS CLASSIFICATION SHEET

CGSE012, Rev A
Rev: CKSM AD95 Description: HFC-DO8J Firmware

Method (Mark all that apply}

A "YES" in all three criteria is required for the item to be classified as

commercial grade.

YES NO

1 Is the item not subject to design or specification [X] []
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or [X] [ ]
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the [X] []
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item [X] []

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files

Compiled object code designation

Module checksum generated at the time that the PROM is encoded.

PERFORMANCE CRITICAL CHARACTERISTICS:

Initialization control

Responds to messages from the HFC-6000 controller.

Controls digital DO scan function.

Hardware watchdog strobe function

QPP 7.3 Page 3 of 8
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120677-14
CGS CLASSIFICATION SHEET

CGSE012, Rev A
Rev: CKSM AD95 Description: HFC-DO8J Firmware

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[ X ] Method 1 - Special Tests and Inspections.

[ X ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3 Page 4 of 8
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120677-14 Description: HFC-DOBJ Firmware CGSE 012 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification

CC#001 [ Direct verification of source files
Source Code Files

Source code review documentation
Revision record is included in header
section of each source file.

Source code files are under configura-
tion control

Source code reviews generated for
critical source code files.

CC#002 Object code file is designated Direct verification
Compiled object code designation 912067714.hex.
CC#003 Two-byte checksum (AD95) calculated Checksum AD95 is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U5.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120677-14 Description: HFC-DO8J Firmware CGSE 012 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability. Prototype test report
CC#005 Per design specification Source code review
Controls DO scan function Prototype test report
CC#006 Responds to defined ICL messages per Source code review
ICL response function design specification. Prototype test report
CC#007 Per design specification Source code review
Controls watchdog strobe Prototype test report
Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#008 NQA1 QA Program Records of internal and external
Built-in quality audits.

Software review records.
Pototype test records.

Configuration control Direct inspection

Operating history Revision records in source files Direct inspection
indicate up to 15 years operating
history, including the past several CR and SCR database
years at Ulchin NPP.

Problem reporting and resolution Corrective action program in place QPP 16.1 and CR/SCR database
and being used for evaluating and
resolving reported problems. QPP 16.3

HFC supports CFR Part 21 reporting

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120677-14 Description: HFC-DO8J Firmware CGSE 012 Rev: A

Record all M&TE used for this test:
M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

+ + 4 4 4

4 4 * I 4

4 4 4 4 4

4 *1- 4 4-

___ ___ I ___ I ___ I ___ I ___

Condition Report (CR): [ ] Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
Other:

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

9120677-14 Description: HFC-DO8J Firmware CGSE 012 Rev: A
Sheet

Software P/N:
of

CC# P/F/N Performed By Date Verified By Date
001
002
003
004
005
006
007
008
009
010
011
012

4 4 4 .4- -L

I I + 4

I I I -~ +

1 1 4 + 4

-1 i 4 4 4

a a a .j. L

P = Pass, F = Fail, N = Not Applicable

V.'1Wi a.'..• L•I .a• LIW.. JL•.;•UL IL, u~J•;; i ~L,~I Y..I.ULjJkVl LI LJ.IJI i

Verified By
Date:

QPP 7.3
Revision A

Approved By
Date:
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HFC Control System Components
CQ4 Blocks

1. Introduction

HFC control systems use a subsystem called CQ4 to process digital images of analog values
to implement analog control functions. An analog control loop can be described by the
following sequence:

" The state of a process is sensed and converted to a digital image.

" This digital image then is passed to program algorithms that use it to calculate a control
value.

* The control value is converted back to an analog signal.

* This signal adjusts the operation of a field device.

" The operation of the field device then affects the process under control in the desired
manner.

The CQ4 subsystem is a modular, data-driven, high-level programming structure that uses
elements called blocks for constructing the algorithm for individual control loops. These
CQ4 blocks are data structures containing static and dynamic data. The static data is user
defined and consists of such information as block number, type, processing frequency, and
other parameters. Dynamic data consists of inputs from external devices or output values
from other blocks. Each time the algorithm for a particular block executes, the following
operations take place:

* That block evaluates its internal status.

" If the block is active, it obtains new values for its inputs and inserts those new values into
its algorithm.

* The results of the current calculation then overwrite those from the previous cycle, and
these values determine the block output value.

This document describes common CQ4 block functions that execute various support
operations included in most block algorithms.

2. List of CQ4 Blocks
There are 37 CQ4 blocks available for use in the application code for an HFC control system.
The detailed algorithm for each block type is described in a separate appendix to this
document. Table 1 lists each block type defined for the CQ4 subsystem, the appendix that
provides a detailed description of block operation, and a summary of functions supported.

DSOO 1-000-03 3 of 13 Rev A



HFC Control System Components
CQ4 Blocks

Table 1. CQ4 Blocks Designations and Functions-

'Block Appendix Description ATW Caps Alarms

DS001-000-03 4 of 13 Rev A
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HFC Control System Components
CQ4 Blocks

3. Data Structures
[

of CQ4 Blocks

Table 2: Block Data Structure

Field Size Function

4- +

4- I

1-

f *1

Table 3: BL Quality Word Bit/Field Definitions

DSOO1-000-03 6 of 13 Rev A
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ta9 Bit ciion
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DS001-000-03 7 of 13 Rev A



HFC Control System Components
CQ4 Blocks

Table 3: BL Quality Word Bit/ield Definitions (Cont)

Tag. Bit Description

4. CQ4 Block Common Functions

4.1 A TW Processing
Antiwindup (ATW) processing is a method for preventing block output values from
increasing or decreasing beyond safe operating limits for the external process under control.
For example, if a specific block generates a control value for automatic operation while the
field device is in manual mode, the block might begin increasing (or decreasing) its output to
force a response. If the field device is then put into automatic mode, the value of the control
variable could cause severe bumping, which might damage the external hardware. The CQ4
subsystem uses ATW codes to avoid such problems. When a control loop is configured to
use ATW processing, each intermediate block in the control loop uses the ATW code from
its downstream link to limit the magnitude of its output, and it passes ATW codes to each of
its variable upstream input sources. The resulting transfer of ATW codes, combined with

DSOO1-000-03 8 of 13 Rev A



HFC Control System Components
CQ4 Blocks

periodic initialization of the intermediate blocks, ensures that the values of the process
variable (PV) and control output remain within safe limits for system operation. Specific
values for the ATW code and their associated meanings are listed in Table 4.

Table 4: A TW Codes and Associated Meanings
ATW Code• :I: i : : • i• i M eaning.. ii' : •:: i! ::

0 No ATW restrictions exist on current output value.

I Current output cannot be less than previous output.
2: Current output cannot be greater than previous output.
3 Crurrent output is not used.

[
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HFC Control System Components
CQ4 Blocks

6.

4.2 Spans
The important parameters for spans are Input Zero, Input Span, Output Zero, Output Span.
Input Zero and Input Span are used to specify a zero offset and full-scale count for the block
input. A typical calculation associated with these parameters is as follows:
[

.11

4.3 Alarms
Alarms can be sent to an operator station and, optionally, to a printer. Alarm status is
maintained in the quality word of BL, DI, DO, and MS points, and that status can be
downloaded to operator stations along with other dynamic data. The operator stations
include alarm processing software that formats alarm messages for display on alarm
summary graphic pages. The Alarm Parameters are as follows:

" Hi Trigger and Lo Trigger. These two parameters specify limit values used by the
equations program to trigger digital control of alarm processing.

" Hi Alarm and Lo Alarm. These two parameters specify a second set of limit values for
alarm processing.

* Deadband. This parameter enables insertion of hysteresis into transitions from alarm-on
to alarm-off status.
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I

Figure 1: Significant Change Alarm Points
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I

4.4 Clamps
[

0

0

0 I
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4.5 Set Points (SP)
[

Table 5: Possible Block Configurations

Proeessing Mode SP Mode SP Source MN bit : CA bit CM bit

f -4- 4 -4-

4 + 4 4- 4
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1. Introduction

Most of HFC control systems support redundant controller configuration. As shown in

Figurel-1, a redundant configuration consists of two controllers with a dual port memory

(DPM) in between. Each controller in the redundant pair operates in one of two different
modes: primary or secondary mode. The primary controller provides all system control

functions and the secondary controller functions as a hot spare to take over operation on

failure of the primary controller. The transition of control from the primary controller to the

secondary controller is called failover.

The purpose of redundancy is to provide higher reliability of the system. When one

controller fails, the system can still function as normal with the other controller taking over

control. However, it is important to ensure a smooth transition from one controller to another

to prevent potentially hazardous bumping or disturbances to the plant. It is also important to

make sure that the failover mechanism is available. The general way of checking on this is to
perform a regular maintenance procedure by manually trigger a failover to determine if the

secondary is able to take over control properly. This procedure is called maintenance

failover.

I I -Link-

ICL

Figure 1 - Architecture of Redundant Controller Configuration

The purpose of this document is to provide functional descriptions of the redundant
controller configuration and failover mechanism as well as hardware and software design
descriptions to implement these functions.
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2. Functional Description

The main functions for a redundant controller configuration are as follows:

* Negotiation mechanism to determine controller operation mode: Primary or
Secondary

* Failover mechanism on failure of primary controller and synchronization of tasks and
processors

* DPM Data Transfer Mechanism to ensure a smooth transition of control during
failover

* Controller failure detection mechanism
* Maintenance failover mechanism

2.1 Negotiation Mechanism of Controller Operation Mode

Each controller must be able to determine in which mode it should operate: Primary or
Secondary. Therefore, there must be a negotiation mechanism between the redundant
controllers to make sure that one controller is running on Primary mode and the other
controller is running on Secondary mode. The system cannot function properly if both
controllers are in Primary mode, or if no controller operates as the Primary controller.

For a redundant controller configuration, the first controller that finishes initialization will
become the primary controller. The other controller will start operating as the secondary
controller after initialization. For a non-redundant configuration with only one controller,
that controller will operate in Primary mode.

In a multi-processor controller environment, all tasks of each processor operate their
functions in accordance with the operation mode of controller.

2.2 Failover Mechanism and Synchronization

During normal operation, if the primary controller fails, the secondary controller will take
over control and become the primary controller. It is very important that all the tasks running
on all the processors in the same controller are in the same operation mode, either Primary or
Secondary. Otherwise it became an out of SYNC (synchronization) condition. When the
controller's operation mode is changed, the whole controller should perform a
synchronization process for all the tasks on each processor.

2.3 DPM Transfer

During redundant operation, the Primary controller periodically copies dynamic database and
system status data to the DPM. The Secondary controller, on the other hand, periodically
validates the transferred data in the DPM and updates its own record after the data validation
process. This DPM Transferring Mechanism keeps the secondary controller updated with a
current copy of the primary running status and ensures a smooth transition from one
controller to the other in the case of failover. During a failover event when control
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responsibility switches from the Primary to the Secondary, the Secondary retrieves the most

recent application and system status data and uses it as an initial state for starting its control

of the system. Starting with an initial state with most recent dynamic database should

minimize any disturbance to the plant induced by the controller switch over, and prevent

potentially hazardous bumping caused by transfer of control. After switch over is complete,
the Secondary, which is now controlling the plant, switches to operation in the Primary

control mode.

2.4 Controller Failure Detection Mechanism

.1

2.5 Maintenance Failover Mechanism

[

0 ]

3. Description of Hardware Circuitry Design and Signals

The general circuitry design for the failover mechanism and maintenance failover mechanism
is shown in Figure 3-1. CPLD (Complex Programmable Logic Devices) can be used to

provide most of the logics. There are several interconnected signals used to implement the

failover mechanism as shown in Table 3-1.
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3.1 Failover Signals

[

I

Figure 2 - Failover Circuit
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Table 1 - FaiDover Signals

Controller Signal DPM Description

__ I ___ I _____

1- 4

3.1.1 SANE/Signal

[

.]1

3.1.2 PRIMARY/, PRIMARY+, FAILOVER+ and FAILOVER- Signals

II
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3.1.3 MAITENANCE_FAILOVER_ENABLE/

]

3.1.4 REQUESTFORPRI/ and REQUESTFORSEC/ Signals

[
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]

3.1.5 CPUSEL Signals

I

I

3.2 Failover Mechanism

[

.1

3.3 Maintenance Failover Mechanism

]

3.3.1 Request for Controller A to Become Secondary

[
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.1

3.3.2 Request for Controller A to Become Primary

[

4. Description of Software Design

Processor software provides support for the redundant controller configuration and controller

failure detections.

4.1 DPM Transfer

[

.

4.1.1 DPM Availability

[
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I

4.1.2 DPM Ownership

4.1.3 DPM Configuration

[
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.]1

Table 2 - DPM Configuration

Name Size (byte) Descriptions

CQ3 Flags
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4.1.4 CQ3 and CQ4 Data Transfer

[

4. I
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Table 3 - Equation Drop Process Error Codes

Status Code Descriptions

4.2 Controller Failure Detection
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Figure 3 - System Processor Failure Detection

Table 4 - Failover Information in Diagnostic Area
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4.3 Synchronization after Failover
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5. Source Listing

5.1 DPM configuration:

[

5.2 DPM CQ3 and CQ4 drop and pick up routines:

[
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]

5.3 DPM static data equalization:

5.4 System mailbox:

[
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1.0 INTRODUCTION

The Inter-Communications Link (ICL) provides the hardware
between a HFC controller board and configured 1/0 boards.

medium for data transfer
I

2.0 FUNCTIONAL DESCRIPTION

The ICL protocol is an HFC proprietary design used for general communications between a
controller board and an 1/0 board. Its purpose is to provide a fixed format of data transfer for
each type of I/O board. [

I
2.1 REDUNDANT SERIAL LINK
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Figure 1. ICL Architecture

2.2 POLLING

[
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I

2.3 SECONDARY LOOPBACK TEST

II

I

Figure 2. Secondary Loop Back Test
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2.4 SECONDARY POLLING FUNCTION

I

I

3.0 MESSAGE STRUCTURES

Both the 1OIF and the QIO protocols are based on fixed message structures as shown below.
[

IOIF Poll Command Format

zzIIm

___ I I I I I

[I ~Lll]

4-
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QIO Response Message Format

3.1 ADDRESS CODE

QIO Address Code Structure

3.2 MESSAGE CODES

[
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Table 1. Defined Message Codes for HFC Control Systems
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Table. Defined Message Codes for HFC Control Systems (Cont)

Code escritionBytes in Bytes in'
Code ________Description_____________ command reponse

_______ I __________________________________________________________ ________ j __________

4 4- 4

4 4- 4

4 4- 4

-4--

t 4- 4

t 4- 4

4- 4

-4- 4- 4

4 4- 4

*1-- I

4 1- 4

4 4- I
Variable

4--b
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3.3 DATA FIELD

The data field required for each message type is determined by the message code. Most
messages have a fixed byte count based on the board type of the slave station. Certain
message types may have a different byte count depending on specific application. In either
case, both the controller and the slave station used the expected byte count as the basis for
decoding the message received.

3.3.1 Normal Request/Response Message Data Field

[]

Table 2. Data Field for Digital Images

!Byte • Bit7 Bit6 : Bit 5 Bit4 -Bit3 Bit2 . Bitl 1 ,Bit0O
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Table 2. Data Field for Digital Images (Cont)
Byte- i•Bit,7 :i::Bit 6 .BitS:i 5 .Bit 4' •Bit 3 Bit 2' , 1 Si0

Table 3. Data Field for Analog Images

Byte: Bit7 Bit6 Bit5: Bit4 :Bit3 Bit2 Biti 1 Bit 0

ik!
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Table 3. Data FieldforAnalog Images (Cont)

Byte Bit7 I Bit6 1 Bit5 Bit 4 Bit3 i M Bit2 Bit 1 Bit0

:
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Table 4. SOE Time Sync Message Format

Byte! :Bit7 ! Bit6 Bit5 .1 Bit4 Bit3 ::Bit2 1 Bitl I Bit0

3.3.2 Request/Response Message Data Field for the HFC-FPC06

[

]

3.3.3 Special Request/Response Message Data Field

[
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.1

Table 5. Data Formats for FPCO6 Message Transfers

Table 6. Special Request Message

Byte Descriation
Byte Descriotion-,~ 4

4

4

Table 7. Special Response Message

'Byte J Description -

___________________________ I
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3.3.3.1 Diagnostic Request Message

[

]
Table 8. Data Field for Standard Diagnostic Response

Byt Descri ptionf i

1111

______________________ I
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Table 9. Data Field for RTD Diagnostic Response (QIO Protocol)

Byte.. Desiption

ZILIZ

I_ .
+

4-

+

+

+

1-

I I
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Table 8. Data Field for RTD Diagnostic Response (Cono

Table 10. Diagnostic Response Data for DI with Quality Status

Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit I Bit 0
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3.3.3.2 SOE Messages

[

I
Table 11. SOE Record Request Message Data Field Structure

Byte Bit 7 Bit 6 Bit 5 Bit 4 1Bit 3 Bit 2 Bit 1 Bit 0

Table 12. SOE Event Record Formats
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Table 12. SOE Event Record Formats (Cono

Byte I Bit 7 Bit 6 1 Bit 5 Bit 4 Bit 3 1 Bit 2 Bit 1 Bit 0

3.4 SECONDARY LOOP BACK MESSAGE DATA FIELD

]

Table 13. Secondary Loopback Message Exchange

Byte Description .

DS002-000-02 20 of 21 Rev D
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3.5 NACK RESPONSE

NACK is used to signal that a transfer error or timeout has occurred. The NACK response
has no data field.

3.1 CRC-16 ALGORITHM

The CRC-16 is a 16-bit checksum appended to the end of the message. The algorithm is
used by both the transmitter and receiver to check the message for accuracy. The HFC
control system uses the same CRC-16 algorithm for all message transfers. This algorithm is
the same as the one used for the MODBUS protocol. [

I
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1.0 SCOPE

This document covers requirements for the SC, SEP, and SAP firmware code for
controllers used in HFC control systems. The HFC-SBC06 and ECS-SBC06 assemblies
include one each of these controller types. The HFC-SCG06 assembly contains one SC
processor and two SEP processors. Functional differences in the operation of the
program code will be determined by hardware configuration, which will be sensed by the
code during its initialization sequence.

2.0 PURPOSE

This document defines overall requirements for the SC, SAP, and SEP firmware to be
used by the HFC controller assemblies. [

]

3.0 REFERENCES

WI-ENG-202 Development of Software/Firmware Requirements Specifications
DSOO1-000-01 Operating System Component Design Specification
DS002-000-01 C-Link Protocol Design Specification
DS002-000-03 UCP Protocol Design Specification
RS901-000-01 HFC-6000 Product Line-Requirements
700901-04 HFC-DPM06 Requirements Specification
700901-05 HFC-SBC06 Requirements (Hardware) Specification
RS901-000-32 HFC-SCG06 Requirements (Hardware) Specification
400960-01 HFC-SCG06 Schematic Diagram

4.0 FUNCTIONAL ANALYSTS

The HFC-SBC06 hardware assembly is designed for installation in a standard HFC-6000
chassis. The hardware assembly has one SC processor section, one SAP processor
section, and one SEP processor section. The SC processor is designated as the main
processor. It executes the application program and monitors overall status for the
controller. The SAP and SEP processor operate independently of the SC processor and
independently of one another. The SAP processor controls scan cycles with configured
I/O modules via a serial ICL. The SEP processors controls redundant serial interfaces
with the C-Link to enable controller-to-controller communication. The HFC-SBC06
controller is typically configured to control one or more field processes via a combination
of discrete and analog I/O signals. It may be configured for either redundant or non
redundant operation.

The HFC-SCG06 hardware assembly is also designed for installation in a standard HFC-
6000 chassis. The hardware assembly has one SC processor section and two SEP
processor sections. Each of the SEP processors will control redundant serial interfaces
for separate C-Links. One of the two C-Links will serve as the common communication
link with other HFC-SCG06 and ECS-SBC06 remotes and also provide the path for
status transfer to external workstations. The second C-Link will provide the mechanism
for communication with a maximum of 64 HFC-SBC06 controllers. The HFC-SCG06
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module will perform the function of a Communication Master (CM) remote and will not
be used for functional control of any field process. Accordingly, its application program
will be restricted to data mapping functions.

4.1 REQUIREMENTS ANALYSIS

4.1.1 SC Firmware Requirements

[

5.
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Table 1. DIP Switch Configuration Data

Switch Function

+

+

.1-

4-

4-

I

I
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16.

4.1.2 SEP Firmware Requirements

[
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4.1.3
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SAP Firmware Requirements

I
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14.

4.1.4 CPUD Program Code

[
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]

4.2 CONCEPTIONAL DESIGN DESCRIPTION

4.2.1 Overview of Proiect

[

.1

4.2.2
[

Assumptions

0

II

4.2.3 Critical Issues

I

I

5.0 SAFETY ANALYSES

[
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5.1.2 Hazard
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5.1.3 Security

[

I

5.1.4 Risk
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5.2 ICL CONTROLLER - SAP CODE
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5.2.1 Criticality

[

I

5.2.2 Hazard
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5.2.4 Risk
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5.3 C-LINK CONTROLLER - SEP CODE
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5.3.1 Criticality

II
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Section 1

GENERAL INFORMATION

1.1 INTRODUCTION

This document provides a detailed description of the test system application program
(TSAP) that will make up the HFC, HFC-6000 test specimen to be presented for
qualification by the NRC.

1.2 REFERENCES

EPRI TR-107330 Generic Requirements Specification for Qualifying a

700901-01

700905-01

700906-01

700907-01

700908-01

700901-09

700910-01

Commercially Available PLC for Safety-Related Application in
Nuclear Power Plants

HFC-6000 Requirements Specification

Analog Composite Logics

Digital Composite Logics

Schematic Wiring Diagram - TSAP

Schematic Wiring Diagram - HPAT

TSAP Requirements Specification

PCB Card Layout Diagram - TSAP

1.3 ABBREVIATIONS AND ACRONYMS

BIT Built-in Test

CPC Communication Protocol Controller

CRC Cyclical Redundancy Check

CREVAS Control Room Emergency Ventilation Actuation System

CSM Control Switch Module

DCS Distributed Control System

ESF Emergency Safety Feature

ESFAS Emergency Safety Feature Actuation System

4
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EWS Engineering Workstation

HFC HF Controls

ICL Intercommunication Link

I/O Input/Output

JCRT Java CRT Workstation

LAN Local Area Network

M/A Manual/Automatic

MCC Main Control Center

NRC Nuclear Regulatory Commission

OIS Operator Interface System

PCC Peripheral Communication Controller

PID Proportional Integral Derivative. A type of analog control algorithm.

RTD Resistance Temperature Detector

SOE Sequence of Events

TSAP Test System Application Program. A "synthetic application" used to
check/verify the PLC functionality needed to support the qualification test
program.
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Section 2

TSAP Design

2.1 INTRODUCTION

The software installed on the HFC hardware for NRC qualification will include operating
system software and the TSAP installed on the master controller and a separate executive
program on each I/O card. The software for each card will be installed in PROM, but the
master controller will copy the program instructions to flash memory and run from flash
memory during normal operation.

2.2 APPLICATION PROGRAM SOFTWARE

Document 700901-09 TSAP Requirements Specification defines the requirements of the
TSAP. The following will describe the software design required to implement those
requirements. The TSAP is based on a set of simulated control loops and program code to
support operability and prudency test.

2.2.1 SIMULATED CONTROL LOOP LOGIC

2.2.1.1 Medium Voltage Switchgear and Load Center Circuits (Air Circuit Breaker)

The following describes the typical control function for a medium voltage switchgear.
Section E will describe the specific I/O points to be used for the TSAP.

A. Format
I
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2. I

Figure 4-1
Medium Voltage Switchgear and Load Center

B. Functional Circuit Types

4.

I
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C. General Functions
[

11.

D. Inoperable Detector Functions
A flashing inoperable light and alarm operate under the following conditions to
indicate equipment inoperable. The flashing inoperable light goes to steady when the
start or stop pushbutton is operated and to off when the inoperable condition returns
to normal.
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f.

I

E. I/0 Configuration

[

d.

I
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2.2.1.2 Reversing Motor Starter Circuits

The following describes the typical control function for a reversing motor starter. Section
E will describe the specific I/O points to be used for the TSAP.

A. Format
[

3.

I

Figure 4-2
Reversing Motor Starter
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B. Functional Circuit Types
[

2.

I

C. General Functions
[

8.

I

D. Inoperable Detector Functions
A flashing inoperable light and alarm operate under the following conditions to
indicate equipment inoperable. The flashing inoperable light goes to steady when the

11
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start or stop pushbutton is operated and to off when the inoperable condition returns
to normal.

d.

I

E. I/O Configuration

[I

C. I
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2.2.1.3 Non-Reversing Motor Starter Circuits

The following describes the typical control function for a non-reversing motor starter.
Section E will describe the specific I/O points to be used for the TSAP.

A. Format
[

3.

I

Figure 4-3
Non-Reversing Motor Starter
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B. Functional Circuit Types

2.

C. General Functions

[

5.

I

D. Inoperable Detector Functions
A flashing inoperable light and alarm operate under the following conditions to
indicate equipment inoperable. The flashing inoperable light goes to steady when the
start or stop pushbutton is operated and to off when the inoperable condition returns
to normal.

14
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e.

I

E. I/O Configuration

[

d.
I

2.2.1.4 Solenoid Valve Circuits

The following describes the typical control function for a solenoid valve. Section E will
describe the specific I/O points to be used for the TSAP.

A. Format
I
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3.

I

Figure 4-4
Solenoid Valve

B. Functional Circuit Types
[
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4.

I

C. General Functions
[

6.

I

D. Inoperable Detector Functions
A flashing inoperable light and alarm operate under the following conditions to
indicate equipment inoperable. The flashing inoperable light goes to steady when the
start or stop pushbutton is operated and to off when the inoperable condition returns
to normal.
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d.

I

E. I/O Configuration

[

a. I

2.2.2 TSAP LOGIC ALGORITHMS

A. Format

2.

B. Functional Digital Circuits
I

I
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f.

I

C. Functional Analog Circuits
I
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7.

]
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ERD1 11 VVR - Introduction

Section 1

INTRODUCTION

1.1 SCOPE

This document is the Verification and Validation Report for the ERD 111 project of HF
Controls (HFC). This project was undertaken by HFC to develop a control system
product line specifically for nuclear safety-related applications. The report covers
Verification and Validation activities conducted during the life cycle phases for the
ERD 111 project. During the course of this project, a sample control system and synthetic
application program were developed and subjected to the regimen of tests recommended
by EPRI TR-107330, Generic Requirements for Qualifying a Commercially Available
PLC for Safety-Related Applications in Nuclear Power Plants.

1.2 REFERENCES

The following list contains the industry standards used during the development and
testing of the HFC-6000 product line.

EPRI TR-102323

EPRI TR-106439

EPRI TR-107330

IEC 801-2

IEEE Std 279-1971

IEEE Std 323-1974

IEEE Std 344-1975

IEEE Std 352-1987

IEEE Std 384-1981

Guidelines for Electromagnetic Interference Testing in Power
Plants, Revision I

Guideline on Evaluation and Acceptance of Commercial Grade
Digital Equipment for Nuclear Safety Application

Generic Requirement Specification for Qualifying Commercially
Available PLC for Safety-Related Applications in Nuclear Power
Plants

Electromagnetic Compatibility for Industrial-Process Measurement and

Control Equipment

Criteria for Protection Systems in Nuclear Power Generating Stations

IEEE Standard for Qualifying Class IE Equipment for Nuclear Power
Generating Stations

Recommended Practice for Seismic Qualification of Class IE Equipment
for Nuclear Power Generating Stations
Guide for Principles of Reliability Analysis of' Nuclear Power

Generating Station Protection Systems

Standard Criteria for Independence of Class IE Equipment and Circuits

VV0415 1-1 Rev A
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IEEE Std 603-1991

IEEE Std 828-1990

IEEE Std 929-1983

IEEE Std 830-1993

IEEE Std 1008-1987

IEEE Std 1012-1986

IEEE Std 1028-1988

IEEE Std 1042-1987

IEEE Std 1050-1996

IEEE Std 7-4.3.2

IEEE Std C62.41-1991

IEEE Std C62.45-1992

NQA-1-1993

Standard Criteria for Safety Systems for Nuclear Power Generating
Stations

Standard for Software Configuration Management Plans

Standard for Software Test Documentation

Recommended Practice for Software Requirements Specifications

Standard for Software Unit Testing

Standard for Software Verification and Validation Plans

Standard for Software Reviews and Audits

Guide to Software Configuration Management

IEEE Guide for Instrumentation and Control Equipment Grounding in
Generating Stations

Standard Criteria for Digital Computers in Safety Systems of Nuclear
Power Generating Stations

Recommended Practice on Surge Voltages in Low-Voltage AC Power
Circuits

IEEE Guide on Surge Testing for Equipment Connected to Low-Voltage
AC Power Circuits

Quality Assurance Program Requirements for Nuclear Facilities

The day-to-day operations within HFC are governed by the HFC Quality Assurance
Manual, individual Quality Process Procedures (QPP), and departmental work
instructions. The QA Manual as well as the individual procedures and work instructions
applicable to nuclear safety-related projects were developed based on NQA-1 and the
relevant industry standards.

1.3 DEFINITIONS AND ACRONYMS

1.3.1 DEFINITIONS

Anomaly
Anything observed in the documentation, construction, or operation of the system
that deviates from expectations based on previously verified components or
reference documents.

Fault Tolerance
A built-in capacity of a system to provide continued correct execution in the
presence of a limited number of hardware or software faults.

VV0415 1-2 Rev A
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Legacy Software
Software that had been developed before a comprehensive V&V program had
been established.

Software
Programs, procedures, rules, data, and any associated documentation pertaining to
the operation of a computer system.

Requirements Phase
The period of a computer system life cycle during which functional and
nonfunctional requirements capabilities are defined and documented.
(Nonfunctional requirements include performance, interface, reliability, security,
safety, and environmental concerns.)

Requirements Specification
Documentation of the essential requirements for the components that make up the
overall computer system.

Validation
The process of evaluating an integrated computer system (hardware and software)
or an individual component during or at the end of its development process to
determine whether it satisfied specified requirements.

Verification
The process of evaluating a system or component to determine whether or not the
products of a given development phase satisfy the conditions imposed at the start
of that phase.

1.3.2 ABBREVIATIONS

ACE Adverse Conditions and Events

BOM Bill of Material

COTS Commercial off-the-Shelf

CR Condition Report

HAS Historical Archiving System

HFC HF Controls

HPAT HFC Plant Automated Tester

I/O Input/Output

JCRT Java-based interactive graphic software utility used as a control system MMI

EPROM Erasable PROM

EWS Engineering Workstation

MMI Man-Machine Interface

VV0415 1-3 Rev A
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PC Personal Computer

PCB Printed Circuit Board

PCC Peripheral Communication Controller

PDS Previously Developed Software

PROM Programmable Read-Only Memory

QA Quality Assurance

QC Quality Control

QCRT Interactive graphic software utility designed to operate in a QNX environment

RAM Random Access Memory

SBC Single Board Computer

SOE Sequence of Events

SVV Software V&V

SVVR Software V&V Report

UCP Universal Communication Protocol

V&V Verification and Validation

VV0415 1-4 Rev A
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Section 2

PROJECT PLANNING PHASE

2.1 SCOPE

This section covers all V&V tasks accomplished and the overall results of V&V activities
during the project planning phase.

2.2 REFERENCES

The following major documents and V&V task reports were generated during this phase
of the project life cycle.

Assessment of HF Controls Digital Control Platforms for use in Nuclear Safety Related
Service, Hurst Technologies
TN0401 Master Test Plan
VV0401 Product Development Plan

2.3 SUMMARY OF ACTIVITIES

This phase consisted of a series of planning meetings during which HFC management,
selected engineers, and various consultant experts developed top-level plans for the HFC-
6000 product line. The project that became ERDI 11 started as an outgrowth of S10079,
the Plant Control System (PCS) project for Ulchin Nuclear Power Plant Units 5 and 6,
which was then in process. The initial concept was to qualify the control system
architecture that had just been developed for domestic use with the retrofit market as the
primary targeted customer base.

2.3.1 PRELIMINARY AUDIT

[

VV0415 2-1 Rev A



ERDlll SVVR- Planning Phase

I

2.3.2 PLANNING MEETINGS

[
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2.3.3 PLANNING DOCUMENTS

HFC began this project using the QA program documents and departmental work
instructions that were in place at that time. The following major planning documents
were applicable to this phase of the project.

QAPM
QPP-2.1
QPP-3.2
WI-ENG-003
WI-ENG-008

QA Program Manual
Project Quality Plan
System Life Cycle and Verification/Validation Program
Configuration Management
Validation and Verification Program

2.4 OVERALL ASSESSMENT

[

I
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Section 3

REQUIREMENTS PHASE

3.1 SCOPE

This section covers all V&V tasks and the overall results of V&V activities during the
requirements phase for the development of the new nuclear safety-related product line.
The project was designated ERDI 11, and the product line was named HFC-6000. During
this phase, the requirements for the basic hardware and software components of the
product line were defined. Legacy software modules would be used for practically all of
the system-level software to limit requirements for new software development. As a
result, the vast majority of new design consisted of hardware packaging only.

3.2 REFERENCES

The following
cycle.

PQP 2003-005
700005-02
700005-04
700009-50
700901-01
700901-03
700901-04
700901-05
700901-06
700901-07
700901-09
700901-10
RS901-000-01
RS901-000-02
RS901-000-04
RS901-000-11
RS901-000-12
RS901-000-13
TN0401

major documents were generated during this phase of the project life

ERD 111 Project Quality Plan
CSM Requirements Specification (legacy module)
M/A Station Requirements Specification (legacy module)
ECS-Series I/O Cards Software Design Specification (legacy module)
HFC-6000 Product Line Requirements Specification
HFC-PCC06 Serial Channel Multiplexer Requirements Specification
HFC-DPM06 Dual-Ported Memory Requirements Specification
HFC-SBC06 Controller Card Requirements
General I/O Cards Requirements Specification
FPD and FPC Requirements Specification
TSAP Requirements Specification
HPAT Requirements Specification
HFC-6000 Product Line Requirements Specification
HFC PCB Power Supply 24/48vdc Requirements Specification
FPC06 Controller Software Requirements Specification
HFC Single Loop Controller System Requirements Specification
19 inch Rack Power Supply Requirements Specification
HFC-FPC06 Real-Time Operating System Requirements Specification
Master Test Plan

3.3 SUMMARY OF ACTIVITIES

During this period of the project life cycle, requirements specifications were prepared for
each of the modules that were defined for the initial set of the HFC-6000 product line,
and the Master Test Plan was completed. The original list of hardware modules was
revised to produce the final design requirements for the qualification test specimen and
TSAP.

VV0415 3-1 Rev A
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3.3.1 PROJECT QUALITY PLAN

The Project Quality Plan is a document required by QPP-2.1. Its purpose is to define the
overall scope and specific quality requirements for each project undertaken by HFC.

3.3.2 MODULE REQUIREMENTS SPECIFICATIONS

[

]

3.3.3 HFC-PCC06 SOFTWARE REQUIREMENTS

[

]

3.3.4 HFC-FPC06 SOFTWARE REQUIREMENTS

[
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I
3.3.5 MASTER TEST PLAN

[

]

3.3.6 TSAP REQUIREMENTS

[

3.3.7 HPAT REQUIREMENTS

I

I
3.4
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ASSESSMENT OF OVERALL QUALITY

The individual Requirements Specification Evaluation reports provided a detailed
accounting of all discrepancies that were detected as part of each document review. All
detected discrepancies were resolved before the documents were finally accepted.

3.5 CONCLUSIONS AND RECOMMENDATIONS

[
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Section 4

DESIGN PHASE

4.1 SCOPE

This section covers all V&V tasks accomplished and the overall results of V&V activities
during the design phase. As previously indicated, the vast majority of new design
consisted of hardware packaging only. The scope of new software design was minimal.

4.2 REFERENCES

The following
cycle.

400401-01
400409-01
400414-01
400419-01
400424-01
400429-01
400434-01
400439-01
400444-01
400449-01
400454-01
400459-01
400464-01
400469-01
400474-01
400479-01
400484-03
ADS0401
DD0401
DS002-000-01
DS002-000-02
DS002-000-03

DSOOI-000-01
DSOO1-000-02
DSOO1-000-03
DSOO1-000-07
DSOO1-000-08
DS002-000-01
DS002-000-02
DS002-000-03
DS901-000-01

major documents were generated during this phase of the project life

HFC-ILRO6 Hardware Design Specification
HFC-BPCO 1-19 Hardware Design Specification
HFC-BPEO 1-19 Hardware Design Specification
HFC-SBC06 Hardware Design Specification
HFC-DPM06 Design Specification
HFC-PCC06 Design Specification
HFC-Al I 6F Hardware Design Specification
HFC-AI8L Hardware Design Specification
HFC-AI8M Hardware Design Specification
HFC-AC4K Hardware Design Specification
HFC-DI 161 Hardware Design Specification
HFC-DO8J Hardware Design Specification
HFC-DC33 Hardware Design Specification
HFC-DC34 Hardware Design Specification
HFC-AO8F Hardware Design Specification
HFC-AC36 Hardware Design Specification
HFC-6000 Digital and Analog Board Functional Test
TSAP Design Specification
Test Specimen Design Description
Component Design Specification C-Link Protocol
Component Design Specification ICL Protocol
Component Design Specification Universal Communications
Protocol
Component Design Specification, Operating System
Component Design Specification, Equation Interpreter
Component Design Specification, CQ4 Blocks
Component Design Specification, Job Configuration
Component Design Specification, Redundancy and Failover
Component Design Specification, C-Link
Component Design Specification, ICL
Component Design Specification, UCP
HFC-SBC06 Module Detailed Design Specification
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DS901-000-02
DS901-000-03
DS901-000-04
DS901-000-05
DS901-000-06
DS901-000-07
DS901-000-08
DS901-000-09
DS901 -000-10
DS901-000-11
DS901-000-12
DS901-000-14
DS901-000-19
DS901-000-21
DS901-000-23
MS901-000-01
MS901-000-02
ATP0402
CGSE001
TP0401
TP0402
TP0403
TP0404
TP0405
TP0406
TP0407
TP0408
TP0409
TP04 10
TP0411

HFC-6000 1/0 Card Module Detailed Design Specification
HFC-DO8J Card Module Detailed Design Specification
HFC-DI16I Module Detailed Design Specification
HFC-DC33 Module Detailed Design Specification
HFC-DC34 Module Detailed Design Specification
HFC-AI16F Module Detailed Design Specification
HFC-AO8F Module Detailed Design Specification
HFC-AC36 Module Detailed Design specification
HFC-AI8L Module Detailed Design Specification
HFC-AI8M Module Detailed Design Specification
HFC-AI4K Module Detailed Design Specification
HFC-BPCO1-08 Hardware Design Specification
HFC-PSR06 Hardware Design Specification
FPC06 Controller Software Design Specification
HFC-PCC06 ICL I/O Processor Software Design Specification
HFC-SBC06 Module Design Specification
HFC-6000 I/O Card Module Design Specification
Application Software Objects Test Plan
Commercial Grade Software Evaluation, QNX Operating System
Integration Test Plan
Operability Test Procedure
Prudency Test Procedure
Environmental Stress Test Procedure
Seismic Test Procedure
Surge Withstand Test Procedure
EMI-RFI Test Procedure
TSAP Validation Test Procedure
ESD Test Procedure
Bum-in Test Procedure
Isolation Test Procedure

4.3 SUMMARY OF ACTIVITIES

Detailed definitions of hardware and software designs were accomplished during this
lifecycle phase. In addition, source code evaluation reports and detailed design
descriptions for legacy software components were generated to support commercial grade
dedication of COTS software that had been developed by HFC and had many years of
operating history.

4.3.1 MODULE DESIGN SPECIFICATIONS

I
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4.3.2 LEGACY SOFTWARE COMPONENT DESIGN SPECIFICATIONS

[

I
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4.3.2.1
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Pseudo Code Analysis

[

a I

4.3.2.2 Source Code Review

[

.1

4.3.2.3 Source Code Desi2n Descriptions

[
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I

4.3.3 TEST SPECIMEN DESIGN

4.3.4 TEST PROCEDURES

Each of the detailed test procedures identified in TN0401 were generated and reviewed
internally and then submitted to external consultants for evaluation. Hurst Technologies
provided guidance and critical evaluations during the initial development of these test
procedures.

4.4 EXTERNAL AUDIT
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]

4.5 ASSESSMENT OF OVERALL QUALITY

4.6 CONCLUSIONS AND RECOMMENDATIONS

HFC revised its internal procedures covering design development and its approach to
component documentation based on comments from consultant experts. Because the
internal processes were being developed in parallel with the HFC-6000 components,
implementation of new procedures had to be phased into execution of the on-going
project. Now that internal procedures have been developed to cover development of
safety-related equipment and systems, HFC must ensure that those procedures are
followed consistently.
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Section 5

IMPLEMENTATION PHASE

5.1 SCOPE

The implementation phase is the period during which hardware components are
fabricated and software code is written. The only new software that was generated prior
to execution of the qualification tests was the TSAP and the application software for the
HPAT. (The HPAT software controlled the automated tests and is external to the
qualification system.) Implementation of the program code for the PCC06 and the
FPC06 continued while the qualification tests were being run. All other tasks related to
hardware fabrication only.

5.2 REFERENCES

The following V&V documents and reports were generated during the implementation
phase for hardware and software components:

400401-02
400419-02

400429-02
400439-02
400444-02
700715-00
700907-01
700907-02
700908-10
700909-01
700910-01
700910-02
700911-01
700912-01
700916-01
700916-02
700918-01
ASC0401
DSOOI-000-07

TSOO1-000-01
TS901-000-01
TS901-000-02
TS901-000-03
TS901-000-04

HFC-ILRO6 Test Procedure
HFC-SBC06 Controller, HFC-DPM06 Dual Port Memory, HFC-
BPCO1-19 Backplane, and HFC-BPEOI-19 Backplane Test Procedure
HFC-PCC06 Test Procedure
HFC-AI8L Test Procedure
HFC-AI8M Test Procedure
Test Specimen I/O Wiring Schematic
TSAP Logic Diagram - Main Controller
TSAP Logic Diagram - Single Loop Controller
HPAT Logic Diagram
System Arrangement
Card Layout, Class Q Safety-Related USNRC Test Racks
Card Layout, Class S Non-Safety Related USNRC Tester
HFC-6000 Seismic Test Equipment Layout
System Assembly Drawing
Power Distribution, TSAP Configuration
Power Distribution, Single Loop Configuration
Equipment Assembly, Single Loop Hoffman Cabinet
TSAP Program Listing
HFC-6000 Software Configuration for Nuclear Safety Equipment
Controller
Component Test Procedure
HFC-PCC06 Detailed Prototype Test Procedure
HFC-SBC06/DPM06 Prototype Test Procedure
HFC-AC36 Detailed Prototype Test Procedure
HFC-AI 16F Prototype Test Procedure
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TS901-000-05
TS901-000-06
TS901-000-07
TS901-000-08
TS901-000-09
TS901-000- l0
TS901-000-11
TS901-000-12
TS901-000-13
TS901-000-14
TS901-000-16
TS901-000-43
TROO1-000-01

HFC-AI4K Prototype Test Procedure
HFC-AI8L Detailed Prototype Test Procedure
HFC-AI8M Prototype Test Procedure
HFC-AO8F Prototype Test Procedure
HFC-DC33 Prototype Test Procedure
HFC-DC34 Prototype Test Procedure
HFC-DI 161 Prototype Test Procedure
HFC-DO8J Prototype Test Procedure
HFC-AC38 Detailed Prototype Test Procedure
HFC-PCC06 Detailed Test Procedure
HFC-BPCO1-08 Detailed Prototype Test Procedure
HFC-PCC06 Code Functional Test
Block Algorithm Test Report

5.3 SUMMARY OF ACTIVITIES

5.3.1 HARDWARE FABRICATION

HFC uses external commercial vendors to fabricate PCB assemblies. The documentation
necessary to support prototype fabrication were created, reviewed, and approved during
the design phase, and this package was supplied to the vendor. As prototypes became
available, the hardware designer verified functional operation of the components.
Because this was viewed as part of the hardware design process, no specific software
V&V activities applied. After the designer was satisfied that all design errors had been
identified and corrected, the assemblies were released for production. The final release
package for each PC assembly includes the following items:

* Schematic diagram.
" Assembly diagram and gerber file.
• Bill of Material.
* Production test procedure.
" PROM code files and CPLD code files (if applicable).

Reviews from outside consultants indicated that the production-level test procedures did
not provide adequate formal documentation for prototype approval. Consequently, HFC
developed an additional prototype test procedure for each module and then executed
those tests to document module performance characteristics.

5.3.2 PROGRAM CODE IMPLEMENTATION TASKS

5.3.2.1 TSAP and HPAT Source Code Review

[
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]

5.3.2.2 Application Software Obiects Acceptance Test

[

.1
5.3.2.3 Legacv Software Component Tests

[
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5.3.2.4 HFC-PCC06 Software Test

5.4 ASSESSMENT OF OVERALL QUALITY

5.4.1 HARDWARE IMPLEMENTATION

Fabrication of all hardware components was accomplished by qualified vendors, and the
quality of the resulting components was validated by the test procedure covering that
component. Records of all inspections and tests were included in HFC quality records
for ERDI 11. The scope and formality of prototype testing that had been accomplished
was deemed inadequate for safety-related applications. To correct this discrepancy, HFC
generated a set of detailed prototype tests covering each of the new modules. The new
prototype tests were then executed and the results documented.

5.4.2 SYSTEM SOFTWARE IMPLEMENTATION

Nearly all of the system software is based on legacy software that has been used for many
years. The general approach was to make minimal changes to the software in either
structure or function. Consequently, the V&V tasks for implementation phase consisted
of generating the documentation that would be needed to support commercial grade
dedication.

5.4.3 TSAP AND HPAT CODE

5.5 CONCLUSIONS AND RECOMMENDATIONS

HFC has altered its internal practices to include formally documented prototype tests in
addition to the functional tests used for production assemblies. This was a new step not
previously done. HFC needs to ensure that this exercise is accomplished for all new
hardware and software development. For this purpose, the WI-ENG-107, "Development
of Hardware Test Procedures,' was modified to specify the scope of testing.
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Section 6

INTEGRATION PHASE

6.1 SCOPE

During the integration phase of the life cycle, the hardware components of the Test
Specimen are assembled together and electrically interconnected. Scope of activities
during this phase consists primarily of inspections to verify proper assembly of all
constituent components.

6.2 REFERENCES

The following V&V documents and reports were generated during the implementation
phase for hardware and software components:

TN0401
TP0401
TP0408
TP04 10
TS901-000-30

Master Test Plan
Integration Test Plan
TSAP Validation Test Procedure
Bum-in Test Procedure
Summary Report for Bum-in Test, Setup and Checkout Test,
TSAP Validation Test

6.3 SUMMARY OF ACTIVITIES

Basic fabrication of components was accomplished by outside qualified vendors, who
manufactured the hardware assemblies as commercial grade equipment. The resulting
assemblies were received at HFC and inspected under the HFC QA program. When a
functional module was accepted, it was scheduled for the burn-in test. Nonfunctional
hardware components were assembled by HFC personnel in accordance with process
control sheets and relevant assembly diagrams. Once all of the functional components
had completed bum-in, the modules were installed in the individual modular chassis prior
to the start of the integration test.

6.3.1 BURN-IN TEST

[
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II
6.3.2 INTEGRATION TEST

[

6.3.3 VALIDATION TEST

[

.1

6.4 TEST RESULTS

[
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6

6.5 ASSESSMENT OF OVERALL QUALITY

All the tests except TSAP validation related to hardware performance. No hardware
failures were detected at this time. During TSAP validation, several design and
implementation errors were detected and corrected. Since the test algorithms were
designed 6 months before any part of the hardware existed, existence of these errors is
not prejudicial to the Test Specimen or the TSAP.

6.6 CONCLUSIONS AND RECOMMENDATIONS

Completion of this phase of the testing was satisfactory.
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Section 7

ACCEPTANCE TESTING PHASE

7.1 SCOPE

The first execution of the Operability and Prudency tests were accomplished during this
phase prior to the start of the qualification tests. After completion of the qualification
tests, HFC management decided that the complete seismic test would need to be repeated.
Consequently, both the Operability and the Prudency tests were completely repeated prior
to execution of the seismic retest.

7.2 REFERENCES

The following documents define the tests that were conducted during this phase of the
project.

TP0402
TP0403
TP0408
TP0408B
TS901-000-22
TS901-000-30

Operability Test Procedure
Prudency Test Procedure
TSAP Validation Test Procedure
Test Specimen Validation Test Procedure
Baseline Testing Summary Report
Summary Report for Bum-in Test, Setup and Checkout Test,
TSAP Validation Test

7.3 SUMMARY OF ACTIVITIES

The primary purpose of the tests run at this time was to establish a performance baseline
for the Test Specimen. This baseline performance would then be used during the
qualification tests to detect any degradation caused by the stress conditions being
imposed on the system hardware. These tests all focused on hardware performance, not
execution of the software

7.3.1 INITIAL ACCEPTANCE TEST

7.3.1.1 Operability Test

[
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1

7.3.1.2 Prudency Test

I

]

7.3.2 ACCEPTANCE TESTING PRIOR TO SEISMIC RETEST

[

I
7.3.2.1 Test Specimen Validation

[

I
7.3.2.2 Operability Tests

[

7.3.2.3 Prudency Test

[
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I

7.4 TEST RESULTS

[

I

7.5 ASSESSMENT OF OVERALL QUALITY

[

7.6 CONCLUSIONS AND RECOMMENDATIONS

I

I
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Section 8

QUALIFICATION TEST PHASE

8.1 INTRODUCTION

This section covers activities conducted during on site installation concluding with the
execution of the field performance test.

8.2 REFERENCES

The following documents provided the basis for the tests conducted during this phase of
the ERDI II project.

TP0402
TP0403
TP0404
TP0405
TP0406
TP0407
TP0408B
TP0409
TP0411
TS901-000-22
TS901-000-23
TS901-000-25
TS901-000-28
TS901-000-29
TS901-000-34
TS901-000-35
TS901-000-39
TS901-000-42
TR901-000-02

8.3 SUMMARY

Operability Test Procedure
Prudency Test Procedure
Environmental Stress Test Procedure
Seismic Test Procedure
Surge Withstand Test Procedure
EMI-RFI Test Procedure
Test Specimen Validation Test Procedure
ESD Test Procedure
Isolation Test Procedure
Baseline Testing Summary Report
Environmental Testing Summary Report
EMI/RFI, ESD and SWC Testing Summary Report
Isolation Testing Summary Report
Post Qualification Testing Summary Report
Seismic Retest In-house Testing Summary Report
Seismic Testing Summary Report
Al Response Time Regression Test Report
Failover Regression Test Report
Mailbox Timeout Regression Test Report

OF ACTIVITIES

8.3.1 INITIAL QUALIFICATION TEST SEQUENCE

[

I
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8.3.2 SEISMIC RETEST

[

8.3.3 REGRESSION TESTS

[

.11

]

8.3.3.1 Analog Response Time

]

8.3.3.2 Hardware Watchdog Timeout

[
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I
8.3.3.3 Software Watchdog Timeout Period

[

8.4 EXTERNAL AUDIT

[
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I

8.5 OUTSTANDING ISSUES

[

I
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER: CGSE003

REVISION: A

Safety Related: [X ] YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION: HFC-SBC06 SAP System Firmware

SOFTWARE NUMBER: 9120906-11 Rev: CKSM 27D1

Assigned Engineer:

Technical Reviewer:

Approved By:

V & V Review:

Jonathan Taylor

Steve Yang

Allen Hsu

Bob Cain

Date: 12/15/05

Date: 12/16/05

Date: 12/16/05

Date: 12/16/05
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120906-11
CGS CLASSIFICATION SHEET

CGSE003, Rev A
Rev: CKSM 27D1 Description: SAP Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

SAP processor initialization.

Primary scans configured I/0 modules,

3.

.1
Processor validates all data received from input modules.
[ .I

What are the ways in which the item should fall in actual service?

Program error causes processor stall or invalid branching operation.

Program error results in lost or corrupted I/0 data.
Program error disables required function.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Incorrect program branching without processor stall could result in
loss of I/O data.
Corruption of I/O data image could result in incorrect or unexpected
control of an output channel.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120906-11
CGS CLASSIFICATION SHEET

CGSE003, Rev A
Rev: CKSM 27D1 Description: SAP Firmware

Yes [X] (Item has safety function)

No [ (Item has non-safety function)

Method (Mark all that apply}

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

1 Is the item not subject to design or specification [X] []
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or [X] [ ]
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the [XI []
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item [XI [I

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files

Compiled object code designation

Module checksum generated during compilation and when PROM is encoded.

QPP 7.3 Page 3 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120906-11
CGS CLASSIFICATION SHEET

CGSE003, Rev A

Rev: CKSM 27D1 Description: SAP Firmware

PERFORMANCE CRITICAL CHARACTERISTICS:

Initialization control

System status monitoring and display

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[X] Method 1 - Special Tests and Inspections.

[X] Method 2 - Design Documentation and/or Commercial Grade survey of

vendor.

[ ] Method 3 - Source Verification.

[X] Method 4 Historical Performance Records.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120906-11 -Description:~ SAP Firmware CGSE 003 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification

CC#001 Source files are controlled with limited Direct examination of source files.
Source code files access.

Source code review documentation
Revision record is included in the
header section of each source file. Source code test reports

Source code reviews generated for Prototype test report
critical source code modules.

Module-level test executed for PDS

modules.
CC#002 Object code file designated as Direct verification
Compiled object code designation 9120906.hex

CC#003 One byte compiler checksum value Checksum 27DIH is generated by
Module checksum and PROM part (39H) is inserted as the first byte of ChipWin program at the time the
number the object code header. PROM is encoded.

Two byte object code checksum One byte checksum is generated by
(27D1H) calculated at the time the the compiler and inserted as the first
PROM is programmed. byte of the program header.

Checksum value and PROM part Physical verification of U7 label on
number are printed on a label, and assembly.
that label is affixed to the outside of
the PROM. Direct verification of two-byte

checksum value in PROM header.
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120906-11 Description: SAP Firmware CGSE 003 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review.
Initialization control specification to verify operability

status. Source code test report.
CC#005 Detects failure during initialization Prototype test report
System status monitoring and and prevents start of normal
display operation.

Controls display to indicate normal
cycling operation.

CC#006 [ TR901-000-02

CC#007 [ ] Source code review.

Source code test report.

Functional test.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120906-11 Description: SAP Firmware CGSE 003 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#008 NQA1 QA program Records of internal and external
Built-in quality audits.

Source code review records
Source code test reports
Prototype test report

CC#009 Direct inspection
Configuration control

CC#010 Revision record in file headers Direct inspection of source files
Operating history indicate up to 20 years operating CR and SCR database

history, including the past several Cumulative operating history of
years at Ulchin NPP. generic operating system

CC#011 Corrective action program in place QPP 16.1 and CR/SCR database
Problem reporting and resolution and being used for evaluating and Record of reported errors for generic

resolving reported problems. operating system
HFC supports CFR Part 21 reporting. QPP 16.3

QPP 7.3 Page 7 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120906-11 Description: SAP Firmware CGSE 003 Rev: A

Record all M&TE used for this test:
M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition Report (CR): [ ] Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
Other:

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120906-11 .Description:_ SAP Firmware CGSE 003 Rev: A

Sheet of
CC# P/F/N Preformed By Date Verified By Date
001
002
003
004
004
006
007
008
009
010
011

P = Pass, F - Fail, N = Not Applicable

Characteristics Record Sheet Competition:

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A
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ATTACHMENT 7.1

.COMMERCIAL GRADE SOFTWARE EVALUATION

• EVALUATION NUMBER: CGSE005

S-.REVISION: A

Safety.Relatid: [Y] YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION: 'eHFC-AI 16F Firmware

SOFTWARE NUMBER: 9120680-17, Rev: CKSM A58B

Engineer: Jonathan Taylor .31F.", Date: 12 /15/05

1 Reviewer: Steve Yang /Date: 12/15/05

By: Allen Hsu Date:_. 12/15/05

view: Bob Cain Date: 12/16/05

4;?
44 7

Assigned

Technica

Approved

V & V Re
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120680-17
CGS CLASSIFICATION SHEET

CGSE005, Rev A
Rev: CKSM A58B Description: HFC-AI16F Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of 16-channel 4- to 20-rmA analog input
module.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error results in corruption of AI images.

Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Corruption of Al image results in invalid control of field process.

Loss of communication with controller or loss of image data prevents
reliable control of field process.

Yes [ X J (Item has safety function)

No [ ] (Item has non-safety function)
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120680-17
CGS CLASSIFICATION SHEET

CGSE005, Rev A

Rev: CKSM A58B Description: HFC-AI16F Firmware

Method (Mark all that apply)

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

1 Is the item not subject to design or specification [X] [I
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or [X] [1
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/ supplier on the [XI I
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item [X] I I

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files

Compiled object code designation

Module checksum generated at the time that the PROM is encoded.

PERFORMANCE CRITICAL CHARACTERISTICS:
Initialization control

Internal status monitoring

Hardware watchdog strobe function

AI scan cycle control

Checks calibration and corrects input image for component drift.

Controls alarm for out-of-range input signal.

Response to messages from the HFC-6000 controller.

QPP 7.3 Page 3 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120680-17
CGS CLASSIFICATION SHEET

CGSE005, Rev A
Rev: CKSM A58B Description: HFC-AI16F Firmware

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration Control

Operating History

Problem Reporting and Resolution

METHOD (MARK ALL THAT APPLY):

[ X ] Method 1 - Special Tests and Inspections.

[ X ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120680-17 Description: HFC-AI16 Firmware CGSE 005 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification
CC#001 [ Direct examination of source file.
Source Code Files

Source code review documentation.
Revision record is included in the
header section of each source code
file.

Source files are under configuration
control.

Source code reviews generated for
critical source code files.

CC#002 Object code file is designated Direct verification
Compiled object code designation 912068017.hex.
CC#003 Two-byte checksum (A58B) calculated Checksum A58B is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U5.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120680-17 Description:HFC-AI16F Firmware CGSE 005 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability

status. Prototype test report
CC#005 Per design specification Prototype test report
Controls watchdog strobe

CC#006 Maintains count of communication Source code review of algorithm
Internal Status Monitoring errors

Prototype test report
Detects out-of-calibration status and
sets alarm flag

Detects loss of ICL communication,
and enables hunt mode

CC#007 Per design specification Source code review of algorithm
Input scan function Prototype test report
CC#008 Per design specification Source code review of algorithm
Checks calibration and adjusts input
image for component drift Assembly operates within specified Prototype test report

tolerance after calibration and
remains within tolerance under Qualification test report
environmental stress.

CC#009 Controls alarm indication for out-of- Source code review of algorithm
Controls alarm for out-of-range input range input signal per design
signal specification Prototype test report
CC#010 Responds to defined ICL messages Source code review of algorithm
ICL response function and per design specification

Prototype test report

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120680-17 .Description:HFC-AI16F Firmware CGSE 005 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#011 NQA1 QA Program Records of internal and external
Built-in quality audits.

Software review records.

Prototype test records.
CC#012 Direct inspection
Configuration Control

CC#013 Revision record in file header Direct inspection
Operating History indicates up to 15 years of operating

history, including the past several CR and SCR database
years at Ulchin NPP.

CC#014 Corrective action process is in place QPP 16.1 and CR/SCR database
Problem Reporting and Resolution and being used for evaluating and

resolving reported problems. QPP 16.3

HFC supports CFR Part 21 reporting

QPP 7.3
Revision A

Page 7 of 9



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120680-17 Description: HFC-AI16F Firmware CGSE 005 Rev: A
Record all M&TE used for this test:

M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition Report (CR): [ ] Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ J Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable[ ] Not Acceptable
Other:

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

9120680-17 Description: HFC-AI16F Firmware CGSE 005 Rev A

Sheet

Software P/N:

of
CC# P/F/N Performed By Date Verified By Date
001
002
003
004
005
006
007
008
009
010
011 __ _ _ __ _ _ _ _ _ _ _ _ _

012
013
014

P = Pass, F = Fail, N = Not Applicable

Characteristics Record Sheet Compeitio

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER: CGSE007

REVISION: A

Safety Related: [Y ] YES [ ] NO

MANUFACTURER: HF Controls

DESCRIPTION: HFC-AI8M Firmware

SOFTWARE NUMBER: 9120682-14 Rev: CKSM 8178

Assigned Engineer:

Technical Reviewer:

Approved By:_

V & V Review:

Jonathan Taylor

Steve Yang

Allen Hsu

Bob Cain

Date: 12/15/05

Date: 12/16/05

Date: 12/16/05

Date: 12/16/05

Page 1 of 9



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120682-14
CGS CLASSIFICATION SHEET

CGSE007, Rev A
Rev: CKSM 8178 Description: HFC-AI8M Firmware

1. What is the safety function of the parent component in which this item is

to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of an 8-channel RTD input module.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error results in corruption of data images.

Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent

component or associated components from performing their intended
safety function?

Corruption of Al image results in invalid control of field process.

Loss of communication with controller or loss of image data prevents

reliable control of field process.

Yes X ] (Item has safety function)

No [ ] (Item has non-safety function)

QPP 7.3 Page 2 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120682-14
CGS CLASSIFICATION SHEET

CGSE007, Rev A
Rev: CKSM 8178 Description: HFC-AI8M Firmware

Method (Mark all that apply)

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

1 Is the item not subject to design or specification
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the
basis of specifications set forth in the manufacturer's
published description?

[Xl

[XI

[XI

[I

[I

[I

Commercial Grade Software Item

PHYSICAL CRITICAL CHARACTERISTICS:

[X1 [I

Source code files
Compiled object code designation

Module checksum generated at the time that the PROM is encoded.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120682-14
CGS CLASSIFICATION SHEET

CGSE007, Rev A
Rev: CKSM 8178 Description: HFC-AI8M Firmware

PERFORMANCE CRITICAL CHARACTERISTICS:
Initialization control

Internal status monitoring

Controls AI scan function.

Checks calibration and corrects input image for component drift.

Controls alarm for out-of-range input signal.

Hardware watchdog strobe function

Response to messages from the HFC-6000 controller.

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[ X ] Method 1 - Special Tests and Inspections.

[ X ] Method 2 - Design Documentation and/or Commercial Grade survey of

vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3 Page 4 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120682-14 Description: HFC-AI8M Firmware CGSE 007 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification

CC#001 [ Direct examination of source file.
Source Code Files

Source code review documentation
Revision record is included in the
header section of each source code
file.

Source code files are under configura-
tion control.

Source code reviews generated for
critical source code files.

CC#002 Object code file is designated Direct verification
Compiled object code designation 912068214.hex.
CC#003 Two-byte checksum (8178) calculated Checksum 8178 is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U5.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3 Page 5 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120682-14 Description: HFC-AI8M Firmware CGSE 007 Rev: A

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability. Prototype test report
CC#005 Maintains count of communication Source code review
Internal status monitoring function errors.

Prototype test report
Senses out-of tolerance calibration
status and sets alarm flag.

CC#006 Per design specification and Test Assembly calibration record
Saves calibration data in EEPROM procedure.
CC#007 Per design specification Source code review
Controls AI scan function Prototype test report
CC#008 Per design specification Source code review
Checks calibration and adjusts input
image for component drift Assembly operates within tolerance Prototype test report

after calibration and remains within
tolerance under environmental stress. Qualification test report

CC#009 Activates alarm for over range, under Source code review
Controls alarm for out-of-range input range, and open RTD element
signal Prototype test report
CC#010 Per design specification Source code review
Controls watchdog strobe Prototype test report
CC#011 Responds to defined ICL messages per Source code review
ICL response function design specification Prototype test report

QPP 7.3 Page 6 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120682-14 Description: HFC-AI8M Firmware CGSE 007 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#012 NQA1 QA Program Records of internal and external
Built-in quality audits.

Software review records.

Pototype test records.
CC#013 Direct inspection
Configuration control

CC#014 Revision record in file header Direct inspection
Operating history indicates up to 15 years operating

history, including the past several CR and SCR database
years at Ulchin NPP

CC#015 Corrective action process is in place QPP 16.1 and CR/SCR database
Problem reporting and resolution and being used for evaluating and

resolving reported problems. QPP 16.3

HFC supports CFR Part 21 reporting

QPP 7.3 Page 7 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120682-14 Description: HFC-AI8M Firmware CGSE 007 Rev: A
Record all M&TE used for this test:

M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition Report (CR): [ ] Yes [ I No [ ] N/A If yes, identify below:
CR# [ ]Acceptable[ ] Not Acceptable Initials/Date:
CR# [ ]Acceptable[ ] Not Acceptable Initials/Date:
CR# [ ]Acceptable[ ] Not Acceptable Initials/Date:
Other:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

9120682-14 Description: HFC-AI8M Firmware CGSE 007 Rev: A
Sheet

Software P/N:

of
CC# P/F/N Performed By Date Verified By Date
001
002
003
004
005
006
007
008
009
010
011 __ _ _ __ _ _ _ _ _ _ ___ _ _ _ _ _ _ _ _

012
013
014
015

P = Pass, F = Fail, N = Not Applicable

Characteri1.tic Recor0d.. . ' . ,

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

• EVALUATION NUMBER: CGSE009

REVISION: A

SafetýyRelated: [Y] YES [ ] NrO

MANUFACTURER:," HF Controls

DESCRIPTION:, ,HFC-DC33 Firmware

SOFTWARE NUMBER: 9120676-14, Rev: CKSM 2C30

Assigned Engineer: Jonathan Taylor , "" Date: 12/15/05

Technical Reviewer: Steve Yang / Date: 12/16/05

Approved By: Allen Hsu Date: 12/15/05

V & V Review: Bob Cain Date: 12/16/05&'
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120676-14
CGS CLASSIFICATION SHEET

CGSE009, Rev A
Rev: CKSM 2C30 Description: HFC-DC33 Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of 12-channel DI, 2-channel 120-vac DO
module with coil continuity monitoring.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error prevents transfer of image data to output channels or
corrupts DI image.
Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Failure to update DO channels disrupts control of field process.

Loss of DI data prevents reliable status monitoring of field process.

Loss of communication with controller or loss of image data prevents
reliable control of field process.

Yes [ X ] (Item has safety function)

No [ ] (Item has non-safety function)

QPP 7.3 Page 2 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120676-14
CGS CLASSIFICATION SHEET

CGSE009, Rev A
Rev: CKSM 2C30 Description: HFC-DC33 Firmware

Method (Mark all that apply)

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

1 Is the item not subject to design or specification [X] [I
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or [X] []
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the [X] [1
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item IX] I I

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files

Compiled object code designation

Module checksum generated at the time that the PROM is encoded.

PERFORMANCE CRITICAL CHARACTERISTICS:

Initialization control

Internal status monitoring

Responds to messages from the HFC-6000 controller.

Controls digital I/O scan function.

Hardware watchdog strobe function

QPP 7.3 Page 3 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120676-14
CGS CLASSIFICATION SHEET

CGSE009, Rev A

Rev: CKSM 2C30 Description: HFC-DC33 Firmware

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[X ] Method 1 - Special Tests and Inspections.

[X ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3 Page 4 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120676-14 Description: HFC-DC33 Firmware CGSE 009 Rev: A

Physical Critical Characteristic Acceptance Criteria Method of Verification

CC#001 [ Direct examination of source files
Source Code Files

Source code review documentation
Revision record is included in the
header section of each source file.

Source code files are under configura-
tion control.

Source code reviews generated for
critical source code files.

CC#002 Object code file is designated Direct verification
Compiled object code designation 912067614.hex.
CC#003 Two-byte checksum (2C30) calculated Checksum 2C30 is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U8.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

p76-14 Description: HFC-DC33 Firmware CGSE 009 Rev: ASoftware P/N: 91206

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability.

Prototype test report
CC#005 Monitors excitation voltage status, Source code review
Monitors overall hardware status 120 vac status, and coil continuity

status. Prototype test report

Maintains count of communication
errors.

I
CC#006 Per design specification Source code review
Controls I/O scan function

Prototype test report
CC#007 Responds to defined ICL messages per Source code review
ICL response function design specification.

Prototype test report
CC#008 Per design specification Source code review
Controls watchdog strobe

Prototype test report

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120676-14 Description: HFC-DC33 Firmware CGSE 009 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#009 NQA1 QA Program Records of internal and external
Built-in quality audits.

Software review records.

Pototype test records.

Up to 20 years operating history for
component program files.

CC#010 Direct inspection
Configuration control

CC#O11 Revision record in source file headers Direct inspection
Operating history indicate that all components have

more than 4 years of operating CR and SCR database
history, including the past several
years at Ulchin NPP.

CC#012 Corrective action process is in place QPP 16.1 and CR/SCR database
Problem reporting and resolution and being used for evaluating and

resolving reported problems. QPP 16.3

HFC supports CFR Part 21 reporting

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120676-14 Description: HFC-DC33 Firmware CGSE 009 Rev: A
Record all M&TE used for this test:

M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition Report (CR): [ ] Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
Other:

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

Software P/N: 9120676-14 Description: HFC-DC33 Firmware CGSE 009 Rev: A
Sheet

a

of
CC# P/F/N Performed By Date Verified By Date
001
002
003
004
005
006
007
008
009
010
011 _ _ _ _ _ _ _ _ _

012

P = Pass, F = Fail, N = Not Applicable

CharacteristilS Record h e t -Competition:

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A
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ATTACHMENT 7.1

COMMERCIAL GRADE SOFTWARE EVALUATION

EVALUATION NUMBER:

REVISION: A

Safety Related: [ Y ] YES

CGSE011

[ ]NO

MANUFACTURER: HF Controls

DESCRIPTION: HFC-D1161 Firmware

SOFTWARE NUMBER: 9120686-14 Rev: CKSM 3A5B

Assigned Engineer: Jonathan Taylor Date: 12/15/05

Technical Reviewer: Steve Yang Date: 12/15/05

Approved By:. Allen Hsu Date: 12/15/05

V & V Review: Bob Cain Date: 12/16/05
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120686-14
CGS CLASSIFICATION SHEET

CGSEO11, Rev A
Rev: CKSM 3A5B Description: HFC-DI161 Firmware

1. What is the safety function of the parent component in which this item is
to be installed?

Controls safety system operation.

2. What is the function of the item?

Controls internal operation of 16-channel DI module.

3. What are the ways in which the item should fail in actual service?

Program error causes processor stall or invalid branching operation.

Program error corrupts DI image.

Program error results in loss of communication with controller.

4. Would any of these postulated failures of the item prevent the parent
component or associated components from performing their intended
safety function?

Corruption of DI data produces inaccurate indication of process status.

Loss of communication with controller or loss of image data prevents
reliable monitoring of process status.

Yes [X J (Item has safety function)

No [ ] (Item has non-safety function)

QPP 7.3 Page 2 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120686-14
CGS CLASSIFICATION SHEET

CGSEO11, Rev A
Rev: CKSM 3A5B Description: HFC-DI161 Firmware

Method (Mark all that apply)

A "YES" in all three criteria is required for the item to be classified as
commercial grade.

YES NO

1 Is the item not subject to design or specification [X] []
requirements that are unique to facilities or activities
licensed or regulated by the USNRC?

2 Is the item used in applications other than facilities or [X] [ I
activities licensed or regulated by the USNRC?

3 Is the item ordered from manufacturer/supplier on the [X] [I
basis of specifications set forth in the manufacturer's
published description?

Commercial Grade Software Item [XI [I]

PHYSICAL CRITICAL CHARACTERISTICS:

Source code files

Compiled object code designation

Module checksum generated at the time that the PROM is encoded.

PERFORMANCE CRITICAL CHARACTERISTICS:

Initialization control

Monitors operating status

Responds to messages from the HFC-6000 controller.

Controls digital DI scan function.

Hardware watchdog strobe function

QPP 7.3 Page 3 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION

Software P/N: 9120686-14
CGS CLASSIFICATION SHEET

CGSEO 11, Rev A
Rev: CKSM 3A5B Description: HFC-D1161 Firmware

DEPENDABILITY CRITICAL CHARACTERISTICS:

Built-in quality

Configuration control

Operating history

Problem reporting and resolution

METHOD (MARK ALL THAT APPLY):

[ X ] Method 1 - Special Tests and Inspections.

[ X ] Method 2 - Design Documentation and/or Commercial Grade survey of
vendor.

[ ] Method 3 - Source Verification.

[X ] Method 4 - Historical Performance Records.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120682-14 -Description: HFC-AI8M Firmware CGSE 007 Rev: A

Cri-ticl ChrceitcAcpac rtramethod of Verification

CC#001 [ Direct examination of source file.
Source Code Files

Source code review documentation
Revision record is included in the
header section of each source code
file.

Source code files are under configura-
tion control.

Source code reviews generated for
critical source code files.

CC#002 Object code file is designated Direct verification
Compiled object code designation 912068214.hex.
CC#003 Two-byte checksum (8178) calculated Checksum 8178 is generated by
Module checksum and PROM part at the time that the PROM is ChipWin program at the time the
number. programmed. PROM is encoded.

PROM part number and checksum Physical verification of label on U5.
value are printed on a label, and this
label is attached to the PROM.

QPP 7.3
Revision A
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

p86-14 Description: HFC-DI161 Firmware CGSE 011 Rev: ASoftware P/N: 9120E

Performance Critical Acceptance Criteria Method of Verification
Characteristic
CC#004 Runs initialization tests per design Source code review
Initialization control specification to verify operability.

Prototype test report
CC#005 Monitors excitation voltage status. Source code review
Monitors overall hardware status

Maintains count of communication Prototype test report
errors.

1.
CC#006 Per design specification Source code review
Controls DI scan function

Prototype test report
CC#007 Responds to defined ICL messages per Source code review
ICL response function design specification.

Prototype test report
CC#008 Per design specification Source code review
Controls watchdog strobe

Prototype test report

QPP 7.3 Page 6 of 9
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS SHEET

Software P/N: 9120686-14 Description: HFC-DI161 Firmware CGSE 011 Rev: A

Dependability Critical Acceptance Criteria Method of Verification
Characteristic
CC#009 NQA1 QA Program Records of internal and external
Built-in quality audits.

Software review records.

Prototype test records.
CC#010 Direct inspection
Configuration control

CC#O11 Revision record in source files indicate Direct inspection
Operating history up to 15 years operating history,

including the past several years at CR and SCR database
Ulchin NPP.

CC#012 Corrective action program is in place QPP 16.1 and CR/SCR database
Problem reporting and resolution and being used for evaluating and

resolving reported problems. QPP 16.3

HFC supports CFR Part 21 reporting.

QPP 7.3 Page 7 of 9
Revision A



COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS M&TE SHEET

Software P/N: 9120686-14 Description: HFC-DI161 Firmware CGSE 011 Rev: A

Record all M&TE used for this test:
M&TE CIN# M&TE Desc. Cal. Due Date M&TE CIN# M&TE Desc. Cal. Due Date

Condition Report (CR): [ ] Yes [ ] No [ ] N/A
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
CR# [ ]Acceptable [ ] Not Acceptable
Other:

QPP 7.3
Revision A

If yes, identify below:
Initials/Date:
Initials/Date:
Initials/Date:
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COMMERCIAL GRADE SOFTWARE EVALUATION
ATTACHMENT 7.1

CGS CRITICAL CHARACTERISTICS RECORD SHEET

9120686-14 Description: HFC-DI161 Firmware CGSE 011 Rev: A
Sheet

Software P/N:

of
CC# P/F/N Performed By Date Verified By Date
001
002
003
004
005
006
007
008
009
010
011__ _ _ _ _ _ _ _

012

P = Pass, F = Fail, N = Not Applicable

Characteristics RecoM% d ht. Co....ii'--

Verified By
Date:

Approved By
Date:

QPP 7.3
Revision A
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1.0 INTRODUCTION

The Equation Interpreter runs as an automatic task of the Operating System (OS) for HFC
controllers. After completion of power-up initialization, the OS calls the Equation
Interpreter task, and it begins operation in a continuous loop. Normally, the Equation
Interpreter task is the last task of OS execution cycle and will exhaust the majority
portion of OS execution cycle time (100 ms usually). [

] As the Equation Interpreter processes each instruction, updated output
images become available to other processors running on this controller or to other
controllers operating in the same control system (Figure 1).

Figure 1. Controller Conversion of Inputs into Outputs

2.0 FUNCTIONAL DESCRIPTION

While the Equation Interpreter is running on a primary controller, it performs the
following operations in a continuous sequence:

" Executes a set of preliminary instructions at the beginning of each processing cycle to
verify internal operating status.

* Processes each instruction in the application program from the section of memory
reserved for this program.

* Updates internal status and checks for UCP messages addressed to it.

" This operation runs as a continuous cycle until the end of OS execution cycle occurs.

* This operation has to complete at least one complete cycle, otherwise a system alarm
will be reported.

While the Equation Interpreter is processing instructions from the application code, it
fetches values from memory, performs the operation(s) defined by the instruction or
passes control to another subroutine. Some of the instructions involve read access to
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specified locations of memory, and others return data to specified locations of memory.
Because the Equation Interpreter typically executes the same combination of instructions
in the same sequence during each processing cycle, the values transferred to memory
typically overwrite the contents generated during the previous processing cycle. The
Interpreter normally continues this manner of operation until it reaches the last instruction
in the application program. At that point the Interpreter updates its internal status, checks
for any messages in its task queue, and then returns to the beginning of the program.
[

2.1 POINT TYPES

The architecture of an HFC control system is based on a set of entities called 'points.' A
particular point type within an HFC control system represents a specific function or range
of functions within the control system. Each point type is represented by an entry in an
Access database, and the point types assigned to each remote within a control system
determine the content of the database directory for that remote. Certain point types (Table
1) constitute functional entities that can be used within an application program. All of
these point types have a fixed data structure, and memory is allocated within a remote for
its configured points during the software build for that remote. The application program
uses the data structures associated with these point types to determine the digital image
for inputs and the current operating status of the process under control; the various
operations defined for the application program enable the controller to update the digital
image of outputs as well as their operating status during each execution cycle.

2.2 EQUATION PROGRAM STRUCTURE

The source code file for an application program using equation statements consists of a
fixed program header followed by a sequential list of program statements. The program
header provides unique identification for this program file, enabling the user to
distinguish one version of an application program from another version of the same
program. The program statements may be represented either in text file format or in
equivalent ladder format. In either case, each equation statement typically uses the
current image of one or more points as input data, executes a specified Boolean or
arithmetic operation to generate a result, and then writes that result into the data structure
for another point.

The format of the text file is designed so that an application design engineer or technician
can easily read the intended operation represented by each line of code. HFC has
designed an equation compiler program that operates as one of the EWS (Engineering
Workstation) suite of programs. [
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]
Table 1. Point Types Valid for Application Code

[Point Definition Structure
Type I

4- I

4 I

t -t

+

+ +

+ I-

4- I
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Point Definition Structure
Type

Table 2. Source Code Header Structure

Name Size (byte) Description

-I-

±

I
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Table 3. Four-Byte Instruction Format

Byte Name Description

2.3 CQ3 PROGRAM STRUCTION

CQ3 is a programming language for that was used to generate application code for HFC
control systems before the equation language was created. A CQ3 program consists of a
sequence of statements with each statement having a single Opcode and one or two
operands. The Opcode for each statement determines the specific operation to be
performed by the equation interpreter, and the operands supply the data to be
manipulated. The point types valid for CQ3 programs and the general structure of object
code instructions are generally identical to those for equation programs, but a different set
of Opcode values are used for CQ3 programs. Macro statements in the source code
distinguish between subroutines used for CQ3 support and those for regular equation
statements. The CQ3 Opcode was used for HFC ECS-1200 product line only. It is not
applicable for HFC-6000 product line.

2.4 INSTRUCTION PROCESSING

[
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Figure 2. Mechanism for Processing Application Code Instructions
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2.5 PROGRAM REGISTER ASSIGNMENTS

The Equation Interpreter program module is written in ASM86 assembly language. This
program employs the 8086/8088 register set for the following specific purposes:

* Register AX normally contains the first two bytes of each instruction statement. The
low byte AL contains byte 0 (usually the bit mask), and the high byte AH contains
byte I (Opcode).

" Register BX normally contains the second two bytes of each instruction statement,
which usually provides the point offset parameter for the instruction.

* Register CX contains count data and is used for string operations and loops.

" Register DX is used for data. The low byte DL is used as the Boolean accumulator
for logic operations. The high byte DH contains questionable status for the point
being processed.

" The stack top serves as the value accumulator.

* DS:DI points to the start of the next instruction in the application code.

3.0 OVERVIEW OF EQUATION INTERPRETER OPERATION

I
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I

3.1 INITIALIZATION FOLLOWING POWERUP

[

I

3.2 NORMAL PROCESSING SEQUENCES

[

I

3.3 TASK INITIALIZATION

[
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Figure 3. Equation Interpreter Initialization Sequence

Figure 4. Equation Itterpreter Reentrant Path
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3.4 APPLICATION CODE PROCESSING (PRIMARY CONTROLLER)

[

Figure 5. Normal Instruction Processing Cycle for Primary Controller

I
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3.5 ADTSCE ROUTINE

[

.1
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Figure 6. ADT_SCE Processing for Primary
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Figure 7. ADT_SCE Processingfor Secondary

II
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3.6 OPCODE PROCESSING ROUTINES

[

3.6.1 Instruction Jump Table

[

II
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Table 4. Control Instruction JAml Table

Instruction Opcode (hex) Description

*1-

-t *1-

.4. *1-

*1- ±

+ +

+ +

.4- 4-

4- 4

1 4

4-

-4- 1-

-1- 1-

.4- -4-

4 4

4 4

4 4

4 4

4 4I

4- *1~

4- -4-
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Table4. Control h structionAddress Table (cont)

Instruction JOpcodc (hex) JDescription
4 +

+ +

4 4

4 i

4 +

4 4
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Table4. Control Ihstruction Address Table (con

Instruction Opcode (hex) J~Description
+ +

+ +

+ +

+ *4-

.4- 1-

.4- 1-

4- .4

4- .4

.4 .4

.4 4

I +

I. I.

4

4

+ -1-

+ +

I I

___ I ___ _________
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Table 4. Control Instruction Address Table (cont)

Instruction JOpcodc (hex) Description

+ +

+ +

+ i

i 4-

4- 4

I 4

4 4

4 4

4 4

I I

i i

+ I-

i

I. I.

4-

4-

4- 4-

+

+ +

+ +

+ +

+ +

.4- 4-

4- 1

I I

4 4

+ 4

4 4

4 4

I 4
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Table4. ControlhIstructionAddress Table D conO

Instruction ]Opcode (hex) ]Description
i i

4 4

4 4

4 4

*1 I

4 4
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Table 4. pcontrol Instruction Address Table (Cont)

Instruction Opcode (hex) Description

4 4

* 4

.4- *1-

+ +

+ +

+ +

.4- 4-

4- 4

4 .4

1 4

4 4

4 4

4 *

i +

4 4

.4- .4-

+ -4-

.4- 4-

+ +

i i

+ 4

+ 4

.4. J
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Table 4. Control Instruction Address Table (Cont)

Instruction_ Opcode (hex) Description

4 4

I 4

[]

3.6.1.1 NOOPINS (Opcode 001, and 6011)

[
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]

3.6.1.2 INITBINS

[

I

3.6.1.3 IFX (Opcodes 011, through 0B 11)

[

Byte Description
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]

3.6.1.4 OUTX (Opcodes 0C1 1 through 15n1)

[

Byte Description
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3.6.1.5 HLDRSMTI (Opcodes 1711)

[
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By~te Description

]

3.6.1.6 TSTX (Opcodes 19, through 2311)

[

Byte Description
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3.6.1.7 CQ3AND and CQ3OR (Opcodes 2411 and 25n)

II

Byte Description

3.6.1.8 GOTOINS (Opcode 2C11)

[
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-Byte Description

I

3.6.1.9 JMP_INS (Opcode 2D11 or 611j)

[

Byte Description
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3.6.1.10 CALLCANR (Opcode 2E11)

Byte Description

i

3.6.1.11 LISTINS and LISTINSCO (Opcodes 2F11 and 6211)

[
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LIST INS Format
Byte Description

Byte Description

______________ I

I

]

3.6.1.12 GOBKINS (Opcode 3011)

[
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3.6.1.13 MATHINS and MATHINS_ (Opcodes 3A11, 3B11, B811, and B9 11)

II

]

3.6.1.14 TIME_C (Opcode 3C11 or 6B11)

[

Byte I Description

40 of 97



Equation Interpreter
Component Design Specification

DSOO1-000-02
Rev A

3.6.1.15 DATEC (Opcode 3D11 or 6C11)

[

Byte Description
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3.6.1.16 GET-Digital Status

[

Byte Description

3.6.1.17 SAVYDigital Status

Byte Description
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.1

3.6.1.18 SAVDF (Opcode 9711)

[

Byte Description
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I

3.6.1.19 AND-Digital Status

[

Byte Description

]

3.6.1.20 OR-Digital Status
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Byte Description

3.6.1.21 SGETDigital Status

Byte Description

I
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3.6.1.22 SAVSDigital Status

I

Byte I Description I
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3.6.1.23 SAVRDigital Status

[

SByte Description

I
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3.6.1.24 SAVA Point and MSG-Point

[

Byte Description
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]

3.6.1.25 GETREMxxx

[

By'te Descriptioni_________
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I
3.6.1.26 IFSKP (Opcode 7F11)

[

Byte Description

I

3.6.1.27 CO Point Instructions

[

I
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3.6.1.27.1 INCCTR (Opcode 7D11)

[

Byte Descriptioni

]

3.6.1.27.2 DECCTR (Opcode 7E1 )

I
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Byte Description

.11

3.6.1.27.3 GETCO (Opcode 8511)

[

Byte Description
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.1

3.6.1.27.4 SAV_CO (Opcode 951)

Byte Description I

3.6.1.27.5 SGETCO (Opcode C51,)

I
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Byte Description

3.6.1.28 TI Point Instructions

[

3.6.1.28.1 GETTIS (Opcode 83n)

[

By~te Description
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I

3.6.1.28.2 GETTIV (Opcode 8411)

[

Byte Description

3.6.1.28.3 SAVTIS (Opcode 9311)

[

Byte Description

55 of 97



Equation Interpreter
Component Design Specification

DSOO1-000-02
Rev A

I

3.6.1.28.4 SAVTIPR (Opcode 9411)

[

Byte Description
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]

3.6.1.28.5 SAVHT (Opcode 9B11)

[

Byte Description

I
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3.6.1.28.6 ANDTI (Opcode A311)

[

3.6.1.28.7 ORTI (Opcode AC11)

II
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.1

3.6.1.28.8 SGETTIS (Opcode C3 11)
[

[ I II

]

3.6.1.28.9 SGETTIV (Opcode C411)

I

59 of 97



Equation Interpreter
Component Design Specification

DSOO1-000-02
Rev A

]

3.6.1.28.10 SAVS_TI (Opcode D311)

[

F I

]

3.6.1.28.11 SAVR_TI (Opcode DB11)

[
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Byte Description

3.6.1.28.12 SAVS_HT (Opcode E811)

[

I I
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I

3.6.1.28.13 SAVRUIT (Opcode E911)

II

]

3.6.1.29 Instructions for Floating-Point BL Values

I

]

3.6.1.29.1 GETBLV (Opcode 89jj)

[

62 of 97



Equation Interpreter
Component Design Specification

DSOO1-000-02
Rev A

3.6.1.29.2 SAVBLV and SAV BLV

[

F I
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]

3.6.1.29.3 SGETBLV (Opcode C911)

II

1

3.6.1.30 Miscellaneous Instructions

The following paragraphs describe processing for instructions that provide input data
directly for instructions that transfer data to or from temporary registers. Temporary
registers are used for storage of intermediate values while processing instructions internal
to an equation statement. Normally, all data transferred to a temporary register while
executing the instructions that make up an equation will be fetched ba-k and processed
before the last instruction of that equation is processed.

3.6.1.30.1 GETTEMPS (Opeode 8B11)

[

I
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Byte Description

]

3.6.1.30.2 GETTEMPV (Opcode 8C11)

I
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3.6.1.30.3 GETVALB (Opcode 8C11)

II

i

i

i

]

3.6.1.30.4 GETVALV (Opcode 8E11)

[

.]

3.6.1.30.5 GETVALF (Opcode 8Fi1)

[

66 of 97



Equation Interpreter
Component Design Specification

DSOOI-000-02
Rev A

3.6.1.30.6 SAVTEMPS or SAVTEMPV (Opcode 9E1 or 9F11)

[

I
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3.6.1.30.7 ANDTEMP (Opcode A8 11)

[

.]

3.6.1.30.8 OR_TEMP (Opcode B111)

[

[ -I

'1

II
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3.6.1.30.9 SGETxx (Opcode CB11 , CC,,, CDj1, and CE11)

[

I

]

3.6.1.30.10 COPYDFQW Instruction (Opcode 7B11)

[
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Byte I Description
-.----- +

+

.4-

.1.

I

3.6.1.30.11 COPYBLRC Instruction (Opcode 7C11)

I
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I

3.6.1.31 Parameter Instructions

[
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3.6.2 Math Instruction Jump Table

I
Table S. Math Instruction Address Table

Instruction 0 code (hex) Description ______

Table 5. Math Instruction Address Table

Instruction Opcode (hex) Description
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.Y.

+

+ 4

+ 4

± +

4 +

4 +

i +

4 4-

4 4

4 .4

* 4

4 4

4 4

I. 4

4 4

+ i

4 4

4 4

4 +

4 4

4 4-

4 4

* 4

+ 4

4 4

4 4

I. 4

I 4

±

4 4

1- .4-

1 1-

4 4

4 4

4 4

4 4

4 4

4 4

4 4

4 4

73 of 97



Equation Interpreter
Component Design Specification

DSOO1-000-02
Rev A

Table 5. Math Instruction Address Table

Instruction Opeode (hex) I Description

4-

4 .1-

_____ I ____ I ______________

74 of 97



Equation Interpreter
Component Design Specification

DS001-000-02
Rev A

I___________ _________ __________________________________

_ _ _ _ I _ _ _ I _ _ _ _ _ _ _

3.6.2.1 Standard Arithmetic Operations

3.6.2.1.1 Integer Operations for CO Points (Opcodes 0011, 0CII, 1811, and 2411)

[

]

3.6.2.1.2 FP Operations for BL Points (Opcodes 0211, 0E 11, 1All, and 2611)

[
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]

3.6.2.1.3 FP Operations for TMP Data (Opcodes 041 n, IC11, and 2811)

[

I
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3.6.2.1.4 Integer Operations for VA Data (Opcodes 0611, 121, lEn, and 2A,1)

]

3.6.2.1.5 FP Operations for FP Data (Opcodes 081,141, 2011 and 2Cll)

[
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3.6.2.2 Comparison Operations

3.6.2.2.1 COMP_CO Operation (Opcodes 3011 thru 3811)

3.6.2.2.2 COMPBL Operation (Opeodes 4011 thru 481j)

1

]

3.6.2.2.3 COMPTMP Operation (Opcodes 501, thru 5811)

[
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.1

3.6.2.2.4 COMP_VA Operation (Opcodes 601, thru 681j)

[]

3.6.2.2.5 COMPFP Operation (Opcodes 701, thru 781j)

[

.1
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3.6.2.2.6 CMPTSE

[
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I

3.6.2.3 Combination Operations

[

3.6.2.3.1 ADD/SUB/MUL/DIVSAVCO (Opcodes 90, 1961, 9C1 , and A2, 1)

[

81 of 97



Equation Interpreter
Comnonent Design Specification

DSOO1-000-02
Rev A

3.6.2.3.2 ADD/SUB/MUL/DIVSAVBL (Opcodes 92 9811, 9E11, and A411)

II
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.1

3.6.2.3.3 SETZ/SET1 Operations (Opcodes B0 11, B211, B6n, and B8 1,)

[

3.6.2.3.4 INCIDEC/SAV CO Operations (Opcodes BCH, C21,, and C8H)

[

.1
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3.6.2.3.5 INC/DEC/SAV BL Operations (Opcodes BE,,, C411, and CA11)

I

]

3.6.2.4 SAVTIPRV Operation (Opcode CE11)

I
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]

3.6.2.5 Parameter Math Instructions

[

ii

3.7 REMOTE DATA JUMP TABLE

[

I
Table 6. Get Remnote Data Address Table

Instruction Opcode (hex) Description

1 1-

4 1-

4 4

4 4

4 4

4 4

4 4
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*1- -~

+ *4-

+ +

+

+ +

+

.4- +

.4- +

+ +

i+

4- +

4 .4-

4 +

.4 4-

4 .4

4 4

4 4

4 4

I- *

I. +

I. +

I. 4
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Table 7. Remote Math Instruction Address Table

Instruction Opcode (hex) Description

i *1

1 4

-I- I

3.7.1 Remote Instruction Operations

[

3.7.1.1 GETREMQW (Opcodes 801, 811, 821, 861, 871 and 8811)

[

By'te [Description ________
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]

3.7.1.2 GETREMTIS, GETREMINT, GETREMFLP

[

Byte Description

]

3.7.1.3 ANDREMQW (Opcodes A011, Al11 , A211, A411, A511, and A6 11)

[
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Byte Description

3.7.1.4 ANDREMTIS (Opcode A3 11)

Byte Description
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3.7.1.5 ORREMQW (Opcodes A911, AA11, AB11, ADII, AEll, and AF11)

[

Byte Description

3.7.1.6 ORREMTIS (Opeode ACI1)

[

Byte ]Description
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3.7.1.7 REM_MATHINS (Opcode B8 11)

[

Byte Description

3.7.1.8 SGET-x (Opcodes CO1 , Clm, C211, C311, C411, C511, C611, C7 11, and C811)

[

Byte Descriptioni
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.]

3.7.2 REMMATHTBL Operations

[

By~te [Description_________
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3.8 CANNED ROUTINES ADDRESS TABLE

[

I
Table 8. Canned Routines Address Table

Routine]T Description
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*1*

i

+

i1

Table 9. CQ4 Algorithmn Address Table

CQ4 Block Type Index Description

__ J __ _________

I
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I

~~1 _________________________ I -

I. t

f

+

TableC9. CQ4Agorithm Address Table iont)

CQ4 Block Type Index Description
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4

4- 4-

-4- +

4- +

Table 9. CQ4 Algorithm Address Table (Cont)

CQ4 Block Type Index Description

Table 10. CQ4 Integer Algorithm Address Table

CQ4 Block Type Index Description
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3.9

4.0

PARAMETER INSTRUCTION PROCESSING

EQUATION TASKS TABLE

4.1 EQUATION INTERPRETER STATUS TABLE

[

Table 11. Equation Interpreter Statuts Table

Name Size (byte) Description
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1. Introduction
An HFC control system is a distributed control system that provides plant monitoring and
control capabilities spread over multiple remote control units. The C-Link LAN enables a
system controller to broadcast data and exchange information among remotes or
communicate with the Operator Station PC. [

Figure 1-1. Architecture of an HFC Control System

2. Functional Description
[
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]

2.1 Hardware Interface

[

1

Figure 2-1 C-Link Structure

.]

2.2 Token Passing
[
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I

2.3 Synchronization on Dual-Channels
I

I

DS002-000-01 7 of 31 Rev C



HFC Control Systems
C-Link Protocol Component Design Specification S/W Component

2.3.1 Structure of the Sequence Number Tables

[

I

Figure 2-2. Sequence Number Tables

2.3.2 Rules for Synchronization

[
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2.4 Interface with Other Processors or Controllers

[

I

2.5 Message Types
[
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]

3. Master For a Moment Token Passing Protocol
I

3.1 CPC States and their associated Timers

3.1.1
[

TO - Offline State

I

3.1.2 T4 - Initial state

[
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I

Figure 3-1 State Diagrain for Token Passing Mechanism
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3.1.3 T1 - Token Holding State
[

3.1.4 T2 - Slave Talking State

[
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I

3.1.5 T3 - Waiting ACK Token State

[

3.2 Recovery Solutions to Fault Scenarios

3.2.1 One node fails to pass the token

[
I

DS002-000-01 13 of 31 Rev C



HFC Control Systems
C-Link Protocol Component Design Specification S1W Component

3.2.2 One node passed token but with communication error
[

)

3.2.3 One node fails to claim token

[
]

3.2.4 One node claimed token but with communication error

[

I

3.2.5 Token claim collision (multiple-tokens)

[ I

3.2.6 Deaf nodes
[

4. DDB Broadcast
[

.1

4.1 DDB Broadcast Table and DDB Filter Table

I
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Figure 4-1. Example of DDB Filter

]

4.2 DDB Structure

I
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Table 4-1. DDB Header

Bytes Name Description

Table 4-2. Point Types for DDB

Index Type Size

5.
1

CPC Processor Software

Layer Structure

I1

5.1
[
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Figure 5-1 Structure of Layers

5.1.1 Public Memory

[

I

5.1.2 Interface Layer

[

I

5.1.2 LLC Layer

[
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5.1.3 MAC Layer -NIC driver

[

]

5.2 Protocol Data Units (PDU) of Each Layer

II

Table 5-1. PD U Header for Interface Layer

Bytes Name Description

Table 5-2. PDU Headerfor LLC Layer

Bytes Name Description
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Table 5-3. Control Byte in the PDUHeader for LLC Layer

Bit Name Description

Table 5-4. PD U Header for AIA C Layer

Bytes Name i Description
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I I

Table 5-5. PDUHeader for NIC Receive Layer

Bytes Name Description

Total 4 bytes.

Table 5-6. Receive Status Byte

Bit Description

.]

5.3 Software Modules
The CPC processor software is designed based on an operating system component. [
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I

DS002-000-01 21 of 31 Rev C



HFC Control Systems
C-Link Protocol Component Design Specification S/W Component

Figure 5-2. CPC Modules and Data Storage
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Figure 5-3. Overview of CPC Communication Module Interactions

5.3.1 Communication Initialization
[
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5.3.2 Transmit

5.3.2.1 Interface Transmit Task
[

]

5.3.2.2 LLC Transmit Task

[
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I

5.3.2.3 NIC Transmit Driver

[

I

5.3.3 Receive

5.3.3.1

[
Receive Interrupt Handler of NIC layer

I
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i

5.3.3.2

[
LLC Receive Task

Interface Receive Task

]

5.3.3.3

[

I
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5.3.4 Timer ISR
[

5.3.4.1 Timer 0 ISR

Type Value Description

5.3.4.2

[

5.3.4.3

[

Timer 1 ISR

I

Timer 2 ISR

]

5.3.5 DDB Process Routine

5.3.5.1 Save DDB

[

5.3.5.2 Put DDB

[

I
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5.3.5.3 Get DDB

[

5.4 Nuclear safety control application
[

Figure 5-4 - Conimmunication Paths of HFC Nuclear Safety Controller

5.4.1 Nuclear Safety Communication Link (C-Link) Software

[
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Table 7 - The comparison between normal C-link operation and unclear safety application

Functions Normal C-link Nuclear safety application

5.4.1.1 Token Passing Scheme

[

]

5.4.1.2 Synchronization on Dual-Channels

[
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I

5.4.1.3 Message Types

]

5.4.1.4 C-Link Processor Software Architecture

[

.1

5.5 Source Listing

[
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1. Introduction
Universal Communications Protocol (UCP) is an HFC proprietary protocol that allows data
to be transferred among nodes/processors/tasks/devices in a multi-layer distributed HFC
control system. The data path can be upward, downward, or within the same layer of
communication links. UCP protocol provides a defined standardized software interface for
multiple layers within the communication system. With UCP protocol, each intelligent agent
within a control system can communicate with other intelligent agents without concern for
what types of media, what kind of configuration or arrangement, or what kind of protocol the
message is to traverse. UCP protocol also guarantees the reliable return of a response
message.

The communication software at each layer interface will take care of hardware arrangement
and specific network topology while abiding with the UCP protocol. There can be different
implementations for the UCP protocol. With UCP protocol as the standard software
interface, the development of communication functions at one layer of the network does not
require detailed knowledge of other layers, while a message can be recognized at all points in
the system and the response message can find its correct path to return to the originator of a
request reliably.

The purpose of this document is to provide both an overview of the functional usage of this
communications protocol and specific message structures currently defined by the protocol.

2. Functional Description
Figure I presents the architecture of a typical HFC control system. An HFC control system
is a distributed control system that provides plant monitoring and control capabilities spread
over multiple remote control units. An operator can send commands or inquiries to a specific
node in the control system through an HMI (Human Machine Interface) such as an operator
station PC. The mechanism behind this communication is based on the UCP protocol.

I
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I

Figure 1. A Typical HFC Contirol System Architecture

2.1 Message Structures
The general structure of all UCP messages consists of a UCP map, followed by the message,
and closing with the trailer.
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Figure 2. UCP Message Structure

[

I

2.2 Two Addressing Methods
[I
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3.

3.1
[

Figure 3. Structure ofAddressing

Detailed UCP Protocol Descriptions

Path Elements
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Table 1. Defined Processor IDs

Name Code Descriptions

Table 2. Defined Application Channel IDs

Name Code I Descriptions

_ _ _ _ _ I _ _ I _ _ __ _ _ _ _

1- 1-

Table 3. Defined Standard UCP Request Codes

UCP Standard Request

t I

t I
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Table 4. Defined MTA Gs (Application Task Numbers)

Name Code Descriptions

I I
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4

+

4

4-

3.2 Remote Status Tables for the Bridge Path Method

I
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L72[ 7 F i_:__

Figure 5. Network Topology

Table 5. Remote Status Array-REMOTEDEFSTRUC

Name Description
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Table 6. Remote Statits Array Entry - REMOTESTA TUSSTR UC

Name Size Description
_____________ (byte)

4. UCP Network Layer Structure
[

Figure 6. Network Layer Structure
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I

4.1 TB Structure

[

Status TB Header UCP Packet

Figure 7. TB Structure
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]
Table 7. Universal TB Elements

4 4

'I 4

4.1.1 TBSTAT Status Byte

[

Table 8. UCP Message Status

Name Value Description

+ +

+ +

+

DS002-000-03 14of 21 Rev B



HFC Control System
UCP Protocol Component Design Specification S1W Component

]

4.1.2 TBERRC Error Code Byte

[

.1
Table 9. UCP Message Error Code

Name Description

4.1.3 TBPCT Packet Size Word
[

4.1.4 TBLNK and TBSTA (Source Path Element)

I

.I

4.1.5 TBCNTL Control byte

[
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I

4.2 UCP/Applications Interface

[

I

4.2.1 Network Interface

[

I
Table 10. Status Structure

Status Size (byte) Description

Table 11. Network Buffer (NRB) Structure
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4.2.1.1 NTWN'_STAT Status Byte

[

4.2.1.2 NTWERRC Error Code

[

I

4.2.1.3 RESCOUNT Response Count

[

I

4.2.1.4 RESPTR Response Pointer

[

I

4.2.1.5 REQCOD Request Code

[

I

4.2.1.6 PROCID Processor ID

I
.1
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4.2.1.7 MTAG Applications Task Number

4.2.1.8 REMOTN Encoded Controller or Remote Number

[

.1

4.2.1.9 LOCBUFPTR Local Buffer Pointer
[

.]

4.2.1.10

[
RMTBUFPTR Remote Buffer Pointer

]

4.2.1.11

[

BYNCT Byte Count

I

4.2.2 UCPSEND Interface

I
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4.3 Application Task Layer
[

I
4.4 Application/Path Interface
[
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4.5
[

Communication Path Layer

.1

4.6
[

Path/Hardware Interface

I

4.7 Hardware Layer
I

I
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Response Messages

Source Listing5.
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Introduction

The system software components of HF Controls control systems are based around the filed
proven "Rev 6.1" software version, with the following differences. The software is intended to
be organized into independent groups based on functionality. Software for all Intel x86
processor based cards utilizes the same "generic" software modules. [

1 Functional Description

1.1 FUNCTIONAL SOFTWARE GROUPS

The purpose of software groups is to be able to include or omit a particular function as desired
without affecting any other software. This is accomplished by creating. a group of software
modules that define any and all of their required parameters and/or support functions, except
for standard "operating system" parameters and functions. To accomplish this, each functional
module must include the assignment and allocation of all parameters and memory that it
requires. Each group must also provide any required initialization software that will be
executed by the operating system during initialization of the card. Each software group is
assigned a unique function code. This function code is used by the initialization software to
define which groups are to be made available for that particular configuration. This concept
allows software functions to be easily included in or deleted from other printed circuited cards
capable of performing that function. It also allows many different functional groups to be
included in the firmware for a particular card, and through proper configuration only have
those required for a particular application be made available during initialization. This feature
can better utilize available memory and processor performance.

1.2 GENERIC SOFTWARE

The goal of generic software is to use the exact same software components wherever possible.
Engineers configure selected components and dedicate them to particular application. The
approach for accomplishing this is to separate all hardware dependent functions from the
remainder of the software for a particular functional group. The software components
containing no hardware specific code can be used in any card requiring that function along with
the hardware specific code for that card. This requires that a standard interface exist between
the non-hardware specific modules and any hardware specific module. Also a standard
interface must exist for the "generic operating system".

1.3 ENHANCED NETWORK INTERFA CE

II
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I

1.4 SOFTWARE ARCHITECTURE

[
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1

1.5 GENERAL SOFTWARE METHODOLOGY

All system utility software was strictly follow standard "Structured Programming" techniques
where ever possible. All parameter definitions, structure definitions, and macro definitions
required for more than one file should be specified in a single location (file), typically in an
"INCLUDE" file.

The underlying principle behind the methodology is to be able to use the exact same files in as
many different applications during the software configuration process. In support of the
principle, the software is organized in self-supporting modules that can be inserted or deleted
as desired for various applications. This requires that modules define all of their required
resources. All files within the module are divided into two categories. The first category of files
contains only applications specific information and contains no hardware specific
requirements. Any hardware specific information must be included in a dedicated file (or files).
This provides the ability to include this module in different hardware by using all of the same
files with the exception of the hardware specific file(s). New hardware specific files must be
created, and included in the module for this new hardware.

This method follows classical layered software techniques, where each layer supports different
aspects of the module. Applications layer software files should contain neither protocol layer
nor hardware layer information. Protocol layer files can be used on any hardware where that
protocol is to be implemented. Hardware layer software files contain all hardware specific
information for that protocol.

The software is designed to support two configurable controller platforms. These two platforms
include multiple bus master controller platforms (such as "Multibus") and Personal Computer
(PC) based platforms. The multiple bus master configuration can also be used to support single
board applications. [
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2 The System Software Components Description

,This section presents descriptions of all system software components for this version. It
includes HFC Generic Operating System (OS) and its utility software. The detail design
descriptions of OS are listed in DSOO1-000-01, Operating System Component Design
Specification.

2.1 OPERA TING SYSTEM SOFTWARE COMPONENT

2.1.1

2.1.1.1

Processor Initialization

System Processor Initialization

I

I

AREA STRUCTURE NAME FILE NAME
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]

2.1.1.2 Subordinate Processor Initialization

[

DSO01-000-06 10of 34 Rev A



HFC Control Systems
System Software Components Design Specification

.1

2.1.1.3 OPERATING MODES

[

I
2.1.1.3.1 Self Test Operating Mode
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[

I

2.1.1.3.2 System Processor Self Test Mode

[

I

2.1.1.3.3 Subordinate Processor Self Test Mode

[

I

2.1.1.3.4 0SX88 Multi-tasking Operating Mode

[

I
2.1.1.3.5 Multitasking Operating Mode Initialization

[
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2.1.1.3.6 Multitasking Operating Mode Applications Execution

[
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2.1.2 Processor Synchronization

[

.1

2.1.2.1 Interface Functions
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The operating system provides several interface functions that are available to all applications
to use during multi-tasking operation. The detail design specifications of all interface functions
are listed in DS001-000-01 OS Component Design Specification.

2.2 UNIVERSAL COMMUNICATIONS COMPONENT

The HFC Universal Communications Protocol (UCP) is a general purpose protocol intended to
allow information to be sent from any location within a system and received by any other
location within the system. The primary goal of the protocol is to allow any available
communications media and arrangement to be transparent to the original source and final
destination of a message. Another goal is to provide a standardized software interface to the
communications system, so that any applications layer software requiring the sending and/or
receiving of a message can achieve its goal independent of the arrangement of the system
configuration. Also, the creation of any new or different applications, requiring
communications can be accomplished by adhering to the documented standard
communications software interface procedure. The UCP is divided into multiple software
layers, with defined standard software interfaces between the various layers. This allows
software within the protocol to be expanded to support newly available hardware
configurations without violating the overall UCP requirements. These new software
procedures can interface with the other layers of the overall UCP thru the defined standard
interfaces. Another goal of the UCP is to provide general purpose communications capability
in the most efficient manner possible. For example, every effort is made to eliminate the need
of copying messages from one memory area to another.

The detail design specification is defined in DS002-000-03 UCP protocol Component Design
Specification.

2.3 SYSTEM DIA GNOSTIC SOFTWARE

The hardware watchdog timer resides on the controller/Controller chassis is the main control
mechanism to report the hardware "Sanity" status. However, in order to strobe this watchdog
timer continuously, all hardware components need to be functioned properly and passed all
checks that are performed by on-line diagnostic software. HFC uses two major groups of
software to prove the operating status of hardware components; they are 1) hardware
initialization diagnostic software and 2) on-line diagnostic software. The checked hardware
components include microprocessors, memory chips and their related circuitries. A 16 bytes
"signature" memory area located at 8FFO:0 had been used as reference for all diagnostic
software. It contains the signature word, starting address of public memory pointer and
remote ID number. The information will be validated during the execution of diagnostic and
communication software continuously.

2.3.1 Diagnostic Software

2.3.1.1 Power up initialization diagnostic software
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During the power up initialization process, the software checks th. following hardware
components and their functions.

* It validates the PROM (EPROM) and FLASH by read the signature.
* It validates the RAM (both private and public) and Dual Ported Memory by write

and read back a particular pattern.
* Validates the status of all configured microprocessors by using the dedicated

diagnostic memory area for each processor.
* Validates the firmware and application code between PROM (EPROM) and Flash
* Synchronize all processors and I/O process by control a system-wide "GO" flag

2.3.1.2 On-line diagnostic software

2.3.L2.1 On-line diagnostic software for controller components

[

Table I - On-line diagnostic software - mailbox validation

Step Controller Function Hardware Diagnostic Note
Involved Software
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Table 2 - On-line diagnostic software and impact hardware

Step Controller Function Hardware Diagnostic Note
IIIInvolved ISoftware

-4

£ L L A
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I

2.3.1.22 On-line diagnostic software for memory components

[

Table 3 - On-line diagnostic functions

Step Controller Function Hardware Diagnostic Note
Involved Software
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1

2.3.2 Memory locations of diagnostic area -

2.3.2.1 SUBPROC segment

[
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]
2.3.2.2 Base on BEGPURMPTR then find public memory root directory

I

I

2.3.2.3 Base on PRSEGDP to find each processor's segment directory

[
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]

2.3.2.4 Base on PRSEGPP pointer to find processor related segment directory

[

I

2.3.2.5 Base on DIAGSP pointer to find diagnostic segment with zero offset
(The offset of DIAGSP is 60H)

[
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2.4 SOFTWARE FILES

All codes for the operating system and its utility software, where ever possible, were
configured to be in the same "Code Segment". All local RAM memory required by the
operating system is configured to be in the same "Data Segment", including all processor
stack areas. This allows any task or function to access any operating system memory variable
using the "SS" register.

2.4.1 Operating System files

[

I

2.4.1.1 Major files

[
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I

2.4.1.2 System Processor Modules

I
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2.4.1.3 Structure Definition

2.4.1.3.1 Controller Configuration Structure

)
I
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Figure I - Configuration Structure Definition

[
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INTRODUCTION

This manual contains user instructions for the One-Step Software supplied with an HFC
Control System and an overview of basic promis-e features.

This manual is part of a set covering the operation and maintenance of the HFC Control
System. All personnel should become thoroughly familiar with the contents of those volumes
relating to their specific responsibilities before attempting to use the control system.

Because it is virtually impossible to cover every situation that might occur during operation
and maintenance of the equipment described in this publication, personnel are expected to
use good judgment when confronted with situations that are not specifically mentioned
herein.
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Section 1

SYSTEM OVERVIEW

1.1 INTRODUCTION

The HFC One-Step Software enables the user to generate the application code executable in
the ECS-1200 controller and AFS-1000 loop controller from promis-e drawings. It also
generates graphic files compatible with HFC MCRT software from the same promis-e

drawings. Thus, the engineers can create and modify control logic application codes of a

loop controller in a completely graphic programming environment. The binary application

code generated can be loaded directly into an EPROM as the application firmware of a loop

controller card. The graphic files can be displayed by MCRT software fir monitoring the

dynamic operation of control loop logic of the application firmware.

The One-Step software is a utility of HFC EWS/MCRT software suite. The promis-e
software is a commercial software package that can be used with HFC-defined macros and

symbols to generate promis-e drawings and report data files. The report files supply the

source of data used by One-Step software to generate its outputs.

1.2 SYSTEM REQUIREMENTS

Minimum hardware and software requirements to run One-Step Software are as follows:

* Intel Pentium PC with a minimum of 128-Mb RAM
* Monitor with 1024*768 screen resolution
* Hard-disk drive with 4 GB or greater storage capacity (mirroring optional)

* 1.44 Mb floppy disk drive
* Mouse and keyboard
0 Microsoft Windows 2000
* AutoCAD Release 2006
0 HFC EWS/MCRT software suite
0 Promis-e software version 5.06

1.3 SUPPORT DOCUMENTATION

• Hardware Manual
" EWS User's Guide
" MCRT User's Guide
" AutoCAD Documentation for Release 2006
* promis-e System Manual software version 5.x

UG004-000-04 1-1 Rev C
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Section 2

OVERVIEW OF ONE-STEP CODE GENERATION

2.1 INTRODUCTION

Application engineers use the promis-e software to define control loop algorithms in the
form of promis-e drawings. The promis-e software runs as an Add-on to AutoCAD and
allows users to set up various attributes for the drawings and their components. The
information for each promis'e project is stored in an associated database, therefore it is
extractable from promis-e.

As a whole control system job may involve a great number of drawings, files, application
codes, and EPROMs, strict configuration management is indispensable. Each single item
needs to have a specific identification number and revision number. After drawings are
modified for a new revision, regenerate the corresponding report files and application codes,
and load these new application codes to the EPROMs. The revision of the final application
code in the EPROM must match the latest revision of promis-e drawings.
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Figure 2-1. System View of Using One-Step Software

2.2 MAKE PROMIS.E DRAWINGS

2.2.1 promise DRAWING ORGANIZATION

The promis-e software organizes files into Projects, Installations, Locations and Pages as
shown in Figure 2-2. A project includes multiple installations, and an installation includes
multiple locations and multiple pages. Page numbering is unique within an installation.

The corresponding set up of PCS control algorithm structure in the promis-e is as follows:

" A control system, for example, SYS_455 is defined as a promis-e project.

* A control loop, for example 0251 is defined as a promis'e installation.

" Symbols in each page define specific logic functions to be performed by the
controller running that logic.
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Figure 2-2. pronmis-e Drawing Organization

2.2.2 SYMBOLS

The One-Step Software can recognize only schematic symbols that have been defined for the
Plant Control System (PCS). If undefined symbols are used to make promis'e drawings,

application codes cannot be generated successfully. Appendix A provides a complete list of

symbols that are recognized by the One-Step Software. The defined symbals are as follows:

I/O Card Symbols represent all types of circuit cards used in the PCS system, such as

AFS series I/O cards, ECS series I/O cards, AFS-SBC04N controller cards, etc.

I/O Card Field Symbols for field inputs and outputs.

* Digital Logic Symbols, such as AND, OR, NOT, TIMER, etc.

* Analog Logic Symbols, such as PID block, DHA block, DLA block, etc.

* DDB Symbols and DDB Filter symbols

* Power Related Symbols.

* Miscellaneous hardware symbols for control switch modules and M/A stations, etc.
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2.2.3 DEVICE TYPES

For the same reason as the symbols, only defined device types can be used to make promis-e

drawings for the One-Step Software. Appendix C provides a complete list of device types
that are recognized by the One-Step Software and the configuration of connection points for
each device type.

2.3 GENERATE promise REPORTS

Running HFC One-Step Macros in promis-e will generate the following four logic reports at

the same time for each system:

* Wire List: wirelist.txt. Wirelist data in this report define how symbols in a drawing are

connected to one another.

" PLC (Programmable Logic Controller) List: plclist.txt. This report defines how I/O
card parent and child symbols are related to one another.

" Loop List: loop_list.txt. It identifies all loops included in a particular system.

" Data List: datalist.txt. It provides specific data for each individual symbol within the

system.

Running HFC One-Step Macros for CAD report will generate CAD reports, ".txt" files.

The HFC One-Step Macros transfer the generated reports to appropriate subfolders

automatically.

2.4 FOLDER STRUCTURE FOR ONE-STEP SOFTWARE

[
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I

Figure 2-3. Folder Structure of Input and Output Files for One-Step Software

2.5 OUTFILES FROM ONE-STEP SOFTWARE

[
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]

2.6 CONTENTS OF ONESTEP.INI

[

.1
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Section 3

promis-e DRAWING CREATION AND MODIFICATION

3.1 INTRODUCTION

promis-e is commercial software that runs as an add-on to AutoCAD and uses the AutoCAD
graphics engine to generate promis'e drawings. Designing in a graphic environment creates
schematics that are easy to read and understand. By using a customized library of symbols,
the user can also create or modify a drawing quickly and easily. Promis'e pages, lines and
symbols have attributes associated with them, and these data attributes are extractable from
the promis-e drawings. In order to provide inputs for the One-Step software, the PCS
schematics have the required data attributes defined, such as logic gates, the timer values, the
analog control blocks, the tuning data, the scaling data, other associated data, as well as the

I/O points and loop numbers, etc.

This section is a brief overview of the features offered in promis-e. For a complete
description, refer to the promis'e system manual and AutoCAD user's guide. Training in the

use of AutoCAD and promis-e is recommended.

Custom symbols and device types have been defined and created to show all of the control
loop logic diagrams required by the system. Only these symbols and device types should be

used to make promis'e drawings for the One-Step software. Appendix A and C provide a list
of the defined symbols and device types. These symbols and device types are available in
the promis-e after the HFC library for the promis-e is installed.

3.2 PRELIMINARY INSTALLATION

1. Install promis'e software as an Add-on to AutoCAD software. Refer to promis-e
System Manual for information about installing and using promis.e.

2. Install HFC library for designing the PCS system under promis'e by copying the HFC
folder to the Catalog folder under promis-e directory. After copying, make sure that
the HFC folder includes "Block", "Device", "Macro", and "Wmf" subfolders.

3. Add HFC Report Macro Function to promis-e menu bar under Tools. First click
Tools > VBA > Run Macro.
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0-•€',?,. -. , tl tl tl tl tl tl tl tl tlx'•,-/ 'I0 - - .J I - .1:

4. When the following dialog window pops up, select the HFCOneStep.AddMenu
macro and click the Run button. The HFC Report Selection appears under Tools
when it is running and ready to be used.

JqP"'M6CF0S ' 11 ý ; ý ý- I I I , 111 i I ! id 11 11 - ! I IB E
Macro name:

I C:\PROMIS-E\Work\acaddvb!HFCOneStep.AddMenu
C:\PROM IS E\Work\acad. dyb!CadData. test
C:\PR0MIS-EWork~acad.dvb!HFC neSte . cadStartup

MOSUVINV," vrr-- .* . I- -.........

C:\PROMIS-E\Work\acad.dvb!HFCOneStep.CADReport
C:\PROMIS-E\Work~acad.dvb!HFCOneStep.CADSYMReport
C:\PROMIS-E\Work\acad.dvb!HFCOneStep.LogicReport
C:\PROMiS .E\Work~acad.dvblHFCOneStep.onestep
C:\PROMIS-E\Work\acad.dvb!HFCOneStep.REmoveMenu

Bun

Help

Itep into

_Edite

Delete

4 1 S 1_J VBA Manager...
E Options...

Macros in: JAII active drawings and projects

Description:

3.3
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OVERVIEW OF promis-e FUNCTIONS

NOTE

promis-e has several ways to perform the same function, such
as menu items, tool bar, shortcut keys, etc. For a more
complete description, see promis-e system manual.

3.3.1 promis'e MENU BAR

The promis-e software supports standard functions such as File, Edit, View, Help functions,
etc, as well as functions related to drawings and reports. The menu bar provides access to
most of the functions as shown:

týi:.l 20 -1;110i]' l*t] ; ESION I --
File Edit View Insert Format Draw Modify Manage Tools Fleports Help

Command:
Command: <Coords off> ___

_Comm.Dand: 7P L ..J2J
ISYS-.431. 0111. NO-.LOC. 1.Onhl2_[½E 4fC'ý.rj.J27 10H"I1] SNAP, GRlD' PRTHO'jPOL)N 0SNAPFOTR4E_

3.3.2 promis-e TOOL BARS

The promis-e tool bars present most of the commands and functions needed to create and edit
control loop diagrams. The tool bars appear around the border of the drawing. These icons
are single click short cuts to items in the pull down menus.

3.3.2.1 ECS promis-e Toolbar

UvA 2 0 - W VERSION ... INlx
File

Manage

Edit Yiew Insert Format Draw Mogdify
Tools fleports Help ._...x

, t I ,Xih

m. a[ECI

It includes the following icons:
" New page
* Page open
" Save
* Print
* Print preview
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* Previous page
" Page refresh
* Next page
* Browse
* Navigator

3.3.2.2 View Toolbar

ED file Edit View Insert Format

Draw Modify Manage Tools Reports

_Help "

Vb•_44J, Z444 Lll,17 U1 Z• j 7 .... 77 I .

It includes the following icons:
• Dynamic Pan
• Dynamic Zoom
" Zoom Window
• Zoom Extent
• Snap from point
• Redraw

3.3.2.3 ECS Modifv Toolbar

8. : w:•In -.w],•J, I IxI

f File Edit View Insert Format Draw
Modifv Manaoe Tools Reports Helb _ Is~ I,

rE "

It includes the following icons:
" GridSnap
* Power-editor
* Change Symbol
" Edit Text
* Modify line
" Delete
" Move
• Copy
" Stretch
" Undo draw
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3.3.2.4 ECS Draw Toolbar

F• *i.,1a ,, :117M _i oIX
F Eile Edit View Insert Format Draw

Modify Manage Tools Reports Help -J6J

I . x2E

-• * . ,--- ../nL •

It includes the following tools for drawing:
" Select symbol
" Draw wire line
* Dashed wire line
* Center Wire line
* 3-Phase Wire
* Last Multi-line
* Text
" Log Field
* Log Box
* Graphical box empty

3.3.2.5 ECS DATA Toolbar

Ft.=, *•IWIiI O. ItElXI
E File Edit View Insert

Format Draw Modify Manage

-10t <Y-
b 0b444 Z4Z7rr__

It includes the following tools:
" New Project
* Symbol Definition
* Macro Definition

3.3.2.6
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DRAW/EDIT Toolbar

It includes standard AutoCAD tools for drawings.

IAA66AD 200i -NTWR VESO -I0

EFile Edit View Insert Format
Tools Reports Help

-1 *D/ r r 0 At-f,rc1I

|

Draw Modify Manage

®,•~ "I [] x,

3.3.2.7 Properties Toolbar

It includes various icons for definitions of page properties.

File Edit View Insert Format Draw Modify Manage Tools Reports Help 16.-2J

.Fc I iJ"01 White 11.1 -- 0 CONTINUOUS a I -J

Dispmays , ~t- UwoltA mI u. ku'

3.3.3 SPECIAL KEYS AND MOUSE FUNCTIONS

The special keys and mouse functions are similar to AutoCAD.

* Left mouse button is the select button
* Right mouse button is the properties button and generally escape/repeat button
" Scroll wheel zooms in and out
* Scroll wheel button

o Push and hold pans
o Double click zooms to extent

NOTE

Pressing the space bar repeats last command.

3.4 DEVICES

Each circuit card used in the control system is considered as a device. A device symbol has

attributes like Device ID, Device Type, and Connection Points. Configuring these attributes

for each circuit card is very important for designing the control systems, and essential for the

success in generating application codes with One-Step software.
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3.4.1 DEVICE TYPE

A device type is a definition that specifies how many and what type of children symbols are
associated with a parent symbol. For a circuit card, the parent symbol is the basic card, and
the children symbols are the I/O points of the card. Therefore, generally the device name
and the parent symbol name are the same for the circuit card symbols defined in the HFC
library.[

%I

3.4.2 DEVICE ID

The device ID identifies a circuit card in the PCS system. Each Device ID must be unique in
a control system and should be predefined for each circuit card. The PCS system uses the
following convention,ýto define the Device IDs for circuit card symbols:

* For AFS I/O cards, the device ID is like "bay##-rack##-sloth#" that indicates the
physical bay, rack, and slot where the card is installed in the system.

* For ECS I/O (MUX I/O) cards, the device ID is like "remote##-link#-#-station##" that

indicates the remote, link, and station required to communicate with the card in the
system.

• For a circuit card symbol, the parent symbol (the card) and the children symbols (the I/O
points) share the same Device ID. Thus the I/O points are superimposed onto the circuit
card.

3.4.3 CONNECTION POINT

Connection Point definition assigns a predefined point address in the control system to each
of the field I/O points, i.e., the children symbols of a circuit card.
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1,.:: oh ectldhPonti. I I 1i I i ;1 1 11Mx

-S elect Connection Points

Device ID: =DATA+L1 -03-4-19

D evice : A103

Installation Pg.Line Symbol Connection Point Addresses I

=0342 2.082 A103 12345678

=0342 2.082 KINPUT 1 AI,41

=0342 2.088 KINPUT 2 AIA2

=0342 2.094 KINPUT 3 AI43

=0342 2.100 KINPUT 4 AI,44

=0342 2.106 KINPUT 5 AIA5

=0342 2.112 KINPUT 6 AIA6

F=0342 2.118 KINPUT 7 AI,47

=0342 2.124 KINPUT 8 AI,48

W j~I ,Help
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" For AFS I/O points, the point address is like "Point Type, Point Number". Such as "DI,
31".

" For MUX I/O points, the point address is like "Remote ##, Point Type, Point Number".
Such as "15, DI, 31".

3.5 DETAILED INSTRUCTIONS FOR USING promis-e

3.5.1 START UP

Invoke the promis-e program by double clicking the promise shortcut on the Windows
desktop.

3.5.2 ADD NEW LOOP SCHEMATIC

3.5.2.1 Create a New Proiect

1. Click Project icon or click File/New/Project from the menu bar as shown.

E File Edit View Insert

Fnorrnj Draw Modify Manage-0ANMZ - 1 1

2. The following window will show up.

JNewPt6iect

Project II
Symbol Library

IHFC
U~ce " ,raeter.; F-Ffonrr

-Title Block Macro - Default Page Macro

i .ITLED c F Ie

Addre::, File. I-_

Projisct Desr:p ,

Job N'rumber

D r a , -.. in g [ Nl u r lb e -r _ _'J

Search Lanqiuagre IeAt..

Decoiptior... Parareter... S-ettircs... Part; Database ...

W j o~o I elp
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3. Enter the Project name first. For example SYS 441 here. Symbol Library should be
HFC for the design of PCS control systems. Then select an existing system in the Use
Parameters From window, such as SYS_431. Enter Project Description, Job
Number, and Drawing Number as required. Click OK.

IN w P oe t I -m : I I1 1 1 II-M 1 1 1

pr ',iF,-: i r' 5

Symbol Library

IHFC

Use Parameters From:

Title Block Macro -Default Page Macro

IKEPCOsD F
Select... Select...

Address File I E

Project Description [

Job Number
±1
ziDrawing Number

Search Language Text...

Description... Parameter... Settings... Parts Datbase...

W o I °°° I elp•

4. The following window will show up.

New P, age

Project : jSYS_441

Installation: [- Select.i

Location: [ Slet...

Page :

FormatName ID-7KEPC(LD

Select Page Format...

Scale 1: F -

[V Online

F Page Type -
ISchematic Diagram •J_

r Title Block -Page Macro Paramete-rs -KEPCO-D 1 2.. 2 1 3... 1 j 4... 5..
S elect... S Select... -2..1j ... i _L o.._ J

I O K I C anc el I Help

Enter loop number to the Installation window, and typically LI in the Location
window.
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--- ..-w-Piagi]

Project : ISYS-441

Installation: 12322 S

Location : IL1 Select...

Page : 1

Format Name ID-KEPCOD i

Select Page Format...

Scale 1: -.
W Online

Page Type ]

Schematic Diagram

Title Block -Page Macro -Parameters---

KEPCOD 2.. 1___._1_ .._ 15_ .

Select... Select. 7 -I

OK Cacllelp

5. The Parameters window provides parameters to define the page. Click button 1 and the
following window will show up.

I Pag'l I1 1

Page Description 1

Date Drawn:

Date Checked

Drawn By.

Checked By

Date Revised

Revised By

Page Description 2

9. Para

10. Para

104/05/02

iHFC

Search Language Text..

OK Cancel Help

6. The Data Drawn is generated automatically. Add or change any parameters as need and
click OK.

7. A blank page in standard format will be generated and is ready to begin drawing on it.

3.5.2.2
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Create a New Page

1. Click new page icon or click File/New/Page from the menu bar as shown.

I'1 AN a2M [IN X•TE3" I

[ File Edit View Insert F~ormat Draw Modify
Manlie lools Reports Help .. I9lX_

11 ,*4 r', t ,+

2. If no project is currently open in promis'e, the following window will show up. Select a
project and click OK, the same window as in Step 4 in Section 3.4.1..1, Create a New
Project, will show up. The same window will show up directly if there is already a
project open in the promis-e.

I Pioe~t NseI6x

F 1roiect

SYS-..431
SYS_441

Search... I

F Lock Project r- Unlock Project

F Cancel flelp

3. If the Project number is not the one desired, click the Select button besides it and a new
window will show up.

UG004-000-04 3-12 Rev C



* S

Section 3 promis-e DRAWING CREATION AND MODIFICATION

"6W Pag6

Project ISYS-441 Select...

Installation: F - elect...

Location [Select...

Page

FormatName ID-KEPCO._D..

Select Page Format...

Scale 1: F-
IV Online

Page Type

ISchematic Diagram

! Title Block -Page Macro Parameters

IKEPCO-D 1 . 2 1 3 1 4 .1 _JE
Select... Select... L I L.J L L. .2.J .I iJ

w Help

4. Select a project from the list and click OK.

1=: xeld N~c

Cancel

5. Follow the instructions from Step 5 in Section 3.4.1.1, Create a New Project, to finish
creating the new page.

3.5.2.3 Copy a Project

Click Manage>Project>Copy from the menu bar and the following window will show up.
Select a project in the From window, and enter a project name in the To window. Click OK
and the whole project will be copied.
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I , co y -lj c x1.iý I I , ý 11

-From:

ISYSTEMPLATE

SYSHOTSPARES
SYSHSIM
SYSMONLIGHT
SYSMSTRAIO
SYS-MSTR_10
SYSMSTRIOX
SYSMUXCABSYS QUAL

[., l F.11 i 61 49 iB
Vl:Rpn Rpbrw-

Search...

INEWI

Wn cel Help

3.5.2.4 Copy an Installation

Click Manage>Installation>Copy from the menu bar and the following window will show
up. Select an installation in the From window, and enter an installation in the To window.
Click OK and the installation will be copied.

Cop I'ia llti a i I
- rrom - -

- Project: Installation:

ISYS-441 12322

SYJUN 2224
SYS_431 - 2231
SYS 433 2321

q~ AA?

To:
-Project: Installation: -

44.1 12329

Location:

P0 Set Pages Online

-Wire Numbers:
'r1 Maintain Add Prefix:

Add Suffix:

I OK ane I Help I
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3.5.2.5 Copy a PaR!e

Click Manage>Page>Copy from the menu bar and the following window will show up.
Select a page in the From window, and enter a page in the To window. Click OK and the
page will be copied.

i•,•'pige.s, 1 1 --- x

Project: - Installation: - Page:

ISYS_441 12322 1

JAS 1363
JUNGHOKIM 2211
KEPCOA 2212
KEPCO B 2213

_ _ _ _ _ _ _ __earK Sev&.

To:
Project: r-Installation: Ltion:

j2322
I ~~~~ ~~1363 A _____ __

2211 _____

2212 Page- _____

2213

P Set Pages Online
17 Renumber All Terminals
i'7 Modify Field Settings

rWire Numbers:

1 Maintain Add Prefix: ] Add Suffix: l
I

~~j ancl Hl

3.5.3 OPEN A PAGE

1. Click page open icon or click File/Open from the menu bar as shown.

. -- !. lIt * Il - x
File Edit View Insert Format Draw Modify

Man~e Tools Reports Help

__ __ , , I1 ,. . I I . 1 1 E , -, .- 1

K-o, Do wE312-7 ý1 Iv-m

FEo
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2. The following window will show up. The Project window displays all the projects
currently in the promis-e. For the PCS, the projects correspond to the control systems.
The Installation window displays all the installations for the selected Project. For the
PCS, the installations correspond to the control loops under a selectedsystem. The Page
window displays all the drawing pages for a selected loop. Normally, there is only one
page for each loop. The Preview window displays a preview of the selected page.

[

3
3. Select proper Project, Installation and Page. Then click OK and the drawing will show

up in the promis-e window.

3.5.4 EDIT A LOOP SCHEMATIC

A loop schematic contains symbols, lines, and text. Right click on a component, an
appropriate editor window will show up with a list of selections to edit. Menus can also be
used to invoke the editors.

To delete, copy or move a component, click menu item Modify>delete, Modify>copy, or
Modify>move. After that, left click on the component in the schematic to select, and then
right click to accomplish the selected operation.

3.5.4.1
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Edit Symbols

3.5.4.1.1 Modify Symbols

1. To modify a symbol, click Modify>Symbol from the menu bar. Left click the symbol
on the schematic to select, and then right click. The following window will show tip.
Select the proper item to modify, and then click OK.

Modiy!SyboV11 11 : 1 771E-3

F- Device ID

F Device Type

F" Connection Point

F- Symbol Text F- Terminal Dest. r Cable Text

r Text Position r Prog. Controller F cross Reference Tog

C-f Text F-- Symbol [ ColorJ

F Angle F- Select...

rF Height Select...

F Label Origin -Select..

-Settings

F Symbol Settings Settings...

Cane o2 I elp

2. An edit window can also show up by right clicking on the symbol as shown. Then select
the proper item to modify.

[

I

3.5.4.1.1.1 Edit Device ID
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1. Select Device ID in the Modify Symbol window and click OK. The following window
will show up. After modifying the Device ID, for example by entering "03-4-17", click
OK.

[]i- *8 *. Il

Installation: 10342 I Search.. I

Location: Ll- Search...

Device ID: Search Device ID

r Suppress Device ID Ir" Du:d.•,at- DL%,,.i: 11 r- Multiple Placement

Part Number-

Assigned Part No./ Select To Delete Search..

Adi.Part N umber

w Cancel I _Help I

2. If Search Device ID is clicked, a new window will show up to obtain a list of currently
defined Device ID for the system.

IS eac eieID rI ' I I E3

Installation:

Location:

Device ID:

II

Function Text: Ll

C I I je

a. The above search string *?* is for Device ID in any pattern. Refine the search by
enter a search string that matches the pattern of Device IDs. For example, this circuit
card is for bay 03. All Device IDs of circuit cards for this bay arc! like "03-##-##".
Therefore enter *03-* and click OK to continue.
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I. Searh 'DiceDI I , E3

Instaflation:

Locaton:

Device ID: pisi

Function Text: U

CIance i ] elp

b. A new window will show up. This window lists Device Ids currently defined for the
system. Make sure the new Device ID doesn't duplicate any existing Device ID.

-I, -6 IIi- IllD
Latallatic .ocatior Device ID Device Function Text

Twoe
=0341 +L1 03-4-1 10-01... TB-R4/L1-C1
=0341 +L1 03-4-2 RSP
=0341 +L1 03-4-3 SBC-...

=0342 +L1 03-4-5 SBC-...
=0343 +L1 03-4-7 SBC-...

=0344 +L1 03-4-8 10-01... TB-R4/L4-C1

=0344 +L1 03-4-9 SBC-...
=0345 +L1 03-4-10 10-01... TB-R4/L5-C1

" A 1 nl.A.11 , r -- J

.....l .

Help

41 I -u
A

3.5.4.1.1.2 Edit Connection Point

Select Connection Point in the Modify Symbol window and click OK. The following
window will show up. Verify that all I/O points are defined, i.e. the Installation and Page
Line columns are filled out. If not, the children symbols must be added to the schematic.
Instructions for adding new children symbols are discussed in later sections.
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-d~ cto Pins 1x11 1 1 1 1 J

- Select Connection Points

Device ID: =CARDDATA+L1-22-2-5
Device: I0-09NRS

I Installation Pg.Line Symbol Connection Point I Addresses
=0342 2.054 I0-09N... 12345676910 7_8_91

=0342 2.066 KINPUT 1 DIX31

=0342 2.068 KINPUT 2 DI,32

-0342 Z072 KINPUT 3 D1,33
=0342 2078 KINPUT 4 D1,34

=0342 2081 KINPUT 5 D1,35

=0342 2.087 KINPUT 6 DI,36

=0342 2054 KINPUT 7 D1,37

=0342 2.057 KINPUT 8 D1,38

=0342 2.063 KOUT... 9 DO,31
=0342 2.060 KOU T... 10 D0,32

11 2345678910

I oK Carncel H _elp

3.5.4.1.1.3 Edit Address (PLC Text)

1. Right click the child symbol of the circuit card and select PLC Text in the pop uip editor
window, and the following window will show up.

2. Change addresses in the window to desired ones, and click OK. After changing the first
point, the other points are populated. For example, change point 0 to "DI, 41" and click
OK or Next, the addresses for other points change to "DI, 42", "DI, 43", etc.
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111 .O Deiiin -x-1 1 1 1 :i1E

Device ID -22-2-5

1.1Cdu!e : I

R l. c k : I

-Address -Function Text-

0 IDI.31

1 I DL,32

2 IDI.33

3 IDj34

IDI,35
ID.36 I

S IDL,37 I
7 IDL38

Nex Ptyous 1/0 Txt [~ ancel

3.5.4.1.1.4 Edit Symbol Text

Select Symbol Text in the Modify Symbol window and click OK. The fbllowing window

will show up. After modifying attribute value, click OK.

x

- ymbol Text -

attribute

attribute

attribute

attribute

ISETPOINT-75 GPM

FGAIN -0.5

lINTEGRAL(SEC) -100

IDERIVATIVE(SEC}-O

Search Language Text...

IW Attributes Only

Next I Fi. I Cancel I help
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3.5.4.1.2 Add Circuit Card Symbols

3.5.4.1.2.1 By Inserting with Macro

Using macros is a quick way to add circuit symbols to the schematic, because the parent
symbol and children symbols are added all at one time and combined together for the circuit

card. However, the following steps must be performed EXACTLY as shown to avoid extra

efforts to detect and fix errors caused by adding macros improperly.

For example, to add an A103 card symbol to the schematic, perform the followings:

1. Click Insert>Select Icon, Insert>Symbol by name, or Insert>Macro by name from
the menu bar, or the Select Symbol icon from the tool bar, and the following window
will show up.
[
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2. Make sure that Macro is selected as shown. Select Yes for the Macro
Settings:>Maintain Device IDs As Created. Then select the A103 icon from icon list
or enter the exact device type name "A103" in the Name box and click OK.
[

]

3. If the symbol name is not known, use Search button to search the symbol name.

[
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]
4. Select the desired symbol name and click OK to continue.

I:. Macro Database I i -1.1 1 1 11 1 1 1 1 11 1 1 ! I I .ý I E 3

Path: IC:\PROMIS.ECATALOG\HFC\macro% " 1 oK I

Catalog Name Tim Description

HFC Al102 N ___________________ ____

H-FC Al102L N
HFC Al103 N ____________________ ____

HFC Al 03C N
HFC Al 03CL N ___________________ _____

H-FC Al103L N _________________ ______

HFC A111 N ____________________ ____

HFC A111L Y
HFC A114 Y __________________ ____

HFC 0141- Y
HFC IA200 ly I _______________________

HFC A200C NI

5. After a new window pops up, click Accept All. Do not change anything in this dialog
window.
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I vi6 I D sin et:

Installation:

Location:

Device ID:

JDATA Search...

Search...

Search Device ID

r- Suppress Device ID F Dupliae Device ID

- Part N umber

Assigned Part No./ Select To Delete Search...

AddiL. Part Number

EIXZ Accep I All Cancel Help I

6. Place the symbol at the desired location in the schematic.

14'."OVAD 20M -NETWORK VERVON I I I 1 4 1 11 11 1 1 1 1

fi .. ,-I- r- D Q - lo eotH

T*A .: . "

M .43.2

Il M. 4 1. . .

.4,6499,21.8475.Q GOO SWAPFORID ORTHO POLAR. OSNAPFOTRACK LWT FMODEL

7. Modify the Device ID for the new symbol to the desired one. For example, in the
following window, change "A 103" to "03-4-19", and click OK.
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ja-~ i D sigm n .: :. I -i 1

Installation:

Location:

IDATA

jlu
Search...

Search...

Device ID: IJOEX Search Device ID

r- Suppress Device ID r- Duplic.ae Devioe ID F Multiple Placement

-Part Number

Assigned Part No./ Select To Delete Search...

Addit. Part Number

XI • I Cancl I -'elp

8. Click OK to change the Device ID for all related components (the card, parent symbol
and children symbols) all at once.

I= I

Do you want to change all related Device IDs?

.Ye s.S•:i .o I oL'I

9. Select Connection Point in the Modify Symbol window and click OK. Verify that the
Installation and Page Line columns are not blank to ensure that al I/O points for the
newly inserted card are defined.
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-,:: Co Seto Pons !II Ix !

-Select Connection Points -

Device ID: =DATA*L1-3-6-13

Device: A103

Installation Pg.Line Symbol Connection Point Addresses

=0342 3.019 A103 12345678

=0342 3.019 KINPUT 1 AIo41

=0342 3.025 KINPUT 2 AI142

=0342 3.031 KINPUT 3 A1o43

=0342 3.037 KINPUT 4 AI.44

.0342 3.043 KINPUT 5 AI.45

=0342 3.049 KINPUT 6 AA4

-0342 3.055 KINPUT 7 A1.47

I K Cancel flelp

3.5.4.1.2.2 By Inserting Symbol Only

1. Click Insert>Select Icon, or Insert>Symbol by name from the menu bar, or the Select
Symbol icon from the tool bar, and the following window will show up.

2. Make sure that Symbol is selected as shown and the Macro Settings:>Maintain Device
Ids As Created shows No. Then enter the exact device type name "A103" in the Name
box and click OK to continue.

Caution

Enter name only and do NOT select an icon from the icon
window. Clicking on an icon causes the symbol to be
added with incorrect settings for its associated macros.

ir

]
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3. After the symbol is placed in the schematic, the following window will show up:

Deicell Asinmn

Installation: 10342

Location: E

Device ID: E4> J -im - -
r- Suppress Device ID F Duqlic.tre Dev'ice tD

Search...

Search...

Search Device ID

r" Multiple Placement

SF'art Number
Assigned Part No./ Select To Delete Search...

INumber

z~z Cancel I 1jelp I

4. Enter Device ID, for example "03-6-13" and click OK to continue.

I v IDI

Installation: 10342

Location: 111

Device ID: 103-6-11

r- Suppress Device ID F [uicat [evice ID

- Part Number

Assigned Part No./ Select To Delete

I=

Search...

Search...

Search Device ID

r- Multiple Placement

Search... N

Addit. Part Number 1

w ac el I el I

5. The following window will pop up. Enter the exact name for device type, for example
"A 103", and click OK to continue.
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I- DeieT p I I1-H H 1

Device Type:

Description:

Searc,.. I. I OK I Cance I Help J

6. Alternatively, click Search button, and then select "A 103" in the following window.

a- . Ia.-b. |

Path: jC:.\PROMIS-E\CATALOG\HFC\device\

Catalog Name Description

HFC AI03

7. The following window will show up for defining connection point.

7. Thefol Poing I : . I I deIning c io point.

- Select Connection Points

Device ID: =0342+L1-03-4-16

Device: A103

Installation
Pg.Line Symbol Connection Point

I ýAll 03 12045678

KINPUT 11
_______KINPUT 2

KINPUT 3
KINPUT 4
KINPUT 5
KINPUT 6

____KINPUT 7
I___ KINPUT 18

112345678

8 r ify t~ht te p• -ild s

8. Verify that the parent symbol and child symbols are correct for the device type. Click
OK, and the following window will show up.
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11/ I.t Deiito Ix 1 ' 0

Device ID -03-4-16

R ki

Address Function Text

0 1.1 F -
1 1? _
2 FI
3 17 ?
4 1?
5 17 ?
7 I

7 W7 I

Nex t ous 9 ,Oxt OK I Cncel

9. Enter the predefined point address for point 0, and the address for other points will

populate from point 0. Then click OK.

Caution

Connection point numbers are I based, for example from
I to 8, whereas the corresponding point addresses are 0
based, for 0 to 7.

1103 x Deiiin I ,x :i E

Device ID -03-4-16

Address Function Text

0 JAL,41

1 IAI.42

2 IA1.43 I
3 I AI.44

4 IAI,45
5 J A1.46

6 JAL,47

7 JAL.48

No 4t 1u 33Text C0nce
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10. For circuit cards with both input and output points, make sure that the populated
addresses are correct.

a. For example, an A200 card has the following child symbols.

z : I . I !I - I ;1 11
-Select Connection Points

Device ID: =0342+L1-03-4-17

Device: A200

Installation Pg.Line Symbol Connection Point

K1 U... 1 m
KOUT... 1
KOUT... 2
KOUT... 3

KOUT... 4
KINPUT 5
KINPUT 6
KINPUT 7
KINPUT 8

o K an ce I Help J

b. Enter the first point, and the other points could be populated as follows:

11 I0 , " . . - I1 " I, I

Device ID -03-4-17
t.,fcjdu ký : I ]
R , -,c k : I

-Addiess Function Text

0 IAo,51
1 Bo.52I

2 A_,53
3 JAo,54I

4 Ao,55I
5 Ao,5 _

6 IA,5 _

7 IAo,58 I

Next ,N] o , I o I ooo
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c. Make sure to correct them for the other types of points.

11 ei. De ir xo

Device ID -03-4-17

1o. _, .
F _:t

p ,. • o
-Address -F-unction I ext

0 IA,51
1 A0_52 1

22 J A0,53 F
3 [A0o543

4 AI,51

5 JAI,52

6 IAI.53
7 PAI,54

Nexo FF, l~ ~o i/o°,II oc,

11. Place the symbol at the desired location in the schematic.

12. Select Connection Point in the Modify Symbol window and click OK to have a look at
the connection point list. The Installation and Page Line columns are blank, which
means that the children symbols need to be added.

z -: C ,hcir Pont I x1
- Select Connection Points

Device ID: =0342+L1-03-5-11
Device: A103

Installation Pg.Line Symbol Connection Point Addresses

=0342 3.0077 Al03 11 2345678
I ~ m [KINU l. i 51

KINPUT 12 Al. 52

KINPUT 3 AIL 53

KINPUT 4 Al, 54

KINPUT 5 Al. 55
KINPUT 6 Al, 56

KINPUT 7 Al. 57

KINPUT 18 Al. 58

II

Cace felep
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13. Click Insert>Select Icon, or Insert>Symbol by name from the menu bar, or the Select
Symbol icon from the tool bar, and the following window will show up.
[

14. Enter "KINPUT" in the Name box as the device type for a child symbol of A 103 card is
"KINPUT". Click OK and place the child symbol to somewhere close to the card
symbol. And the following window will show up.

P= 1-77 -,-7F~~ ~a.M Dl t~~~

12

I:

E9

~. c~

141 to

,4.51 IT

r

0.

El

CL

CL

1 -i I n v I 1-: ý j ti iM
Instdak.,o: 032Sood..

LcP i sS. D~c i . h ..~

D.,ic ID:S-ch~~im K

P uetoviel _________c~

4 4.~ 4'141..IIL0,Oljl I

rmST7..3 0342.11.3. On 6573. 18n u~u SPG-RID- ORTHO POLA~kOS rNIAC WT~ M-ODEL

ia!..!I 1.A.A"CA 20M0 - NET.. IPJDOC~ln -M.Mo,-~Wo '3j Epbiv - F.WFA iQOAMI
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15. Enter the same device ID as the parent symbol, for example "03-5-11 ". Check Suppress
Device ID so that this device ID won't be displayed on the schematic. Click OK to

continue.

I- De i-'ll sig m n I ii H x1 E

Installation:

Location:

10342 Search...

ILl- Search...

Device ID: 103-5-11

I- Suppress Device ID r- Duplicape DctcID

,•.s;i-gned P.,:rf No,/ Sdere To De•-fet

Search Device ID

r- Multiple Placement

I

Addi.J~ Pairt TNumrbe

w K Cancel Ielp
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16. Delete "?" as we don't need any text for the child symbol.

Xl
-Symbol Text

Type II?

Search Language Text...

r Attribute: Only

Nex w Pfvo;II KCne Help I

17. After adding several child symbols in this way, check the Connection Points window of
the circuit card to make sure that these points have been added to the circuit card.

I -,:: xcn e toiP it ;i ý1 1 1I3

-Select Connection Points

Device ID: -0342+L1-03-5-11

Device: A103

Installation Pg.Line Symbol Connection Point

=0342 3.005 A103 1 2345678

=0342 3.005 KINPUT 1

-0342 3.011 KINPUT 2

=0342 3.017 KINPUT 3

KINPUT 5

KINPUT S

KINPUT 7

'c8A

wIe Help
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18. After all the children symbols are added, move them to the circuit card.

3.5.4.1.3 Add a Logic Gate

The following paragraphs outline the method for adding a "NOT" gate input to MS, 53.

[

1. Select Insert>Symbol by name. The following dialog will show up. Select a "NOT"
gate and click OK to continue.
[

2. Place the "NOT" gate at the desired place. The line automatically breaks around the
gate.
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[

By default, a Device ID will appear at the right comer of the newly added "NOT" gate.
However, it is not necessary to have a Device ID for logic symbols on the drawings.
Click on the "NOT" gate, and the following dialog will show up.

]
3.

I D xvd'lDAigmn !1 1 E

Installation: 10002

Location: ILl Search...

Device ID: jý-wchI :. ',DevieI

r- Suppress Device ID r- Duplicate Device ID 1 Multiple Placement

r P a rt N u m b e r 

T D

Assigned Part No./ Select To Delete S earch... I
Addit. Part Number

wK Cancel elp

4. Check Suppress Device ID in the dialog as shown and click OK, the Device ID will
hide from display.
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I............ en I I :1 h I ý

Installation: 10002

Location:

Device ID: IN,24

l .ppjQ !ey''J lb! Duplicate Device ID F

-Part Number

SAssigned Part No./ Select To Delete

Search...

Search...

Sr~arch Device ID

- Multiple Placement

Search...

ddit. Part Number ]A

1=

w Cancel I -Help I
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3.5.4.1.4 Add a Process Control Permissive

1. Find the source device ID of the signal, e.g., 3,FL, 11165 from the source loop.
[

]
2. Add a DDB filter "KINTC" symbol with the same device ID 3,FL,1 1165 to destination

loop. The window below shows the destination loop before adding the symbol.

a 71M A RM I i I ~~ F

Q file Edt !Lrw jnst Fgm.A 2ra. M~ay 11-age lools fleposts ff* .~

3.FL.4193FL.B01

.AMP.TEST PM02 .(ODIS) I ,-. -"- FL1PP1

__ZC .FL.4194 FL ý102 F. . . . .. . . . . . . .. . . . . . . . . .. . . . . .. . . . 3 ,n . -, • 0 •
. . .. .CLOSE MYI. 00.1) INT.4 I . .. ..

M7 STOP PPO03A (LS-e098) .3,FL,,196
•,• ; . .. . . . . INPUT 4 . . . . . . . 2 l112 . .. . . . . . . . .. . .. . .3" ,19• " , • ••
* . INPUT 5) • .INT_? I *1 1".INPIT8 __ _ __ _ __' . {j

3. Follow the same steps as adding a circuit card symbol. Just enter "KINTC" as the name,
select Symbol, and click OK.

[

]
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4. When the following window shows up, enter device ID and installation (the device ID
and installation of source point).

Devi -'I Assignen IX :j

Installation: F
Location:

Device ID:

r Suppress Device ID

r- Pf, l I trnbbN --_

Search...

Search Device ID

r- [.:;lic-J D.....ice ID r- Multiple Placement

Addit. Paft NUTL,-~;

w K Cancel I Help

5. Click OK when the following table shows up.

z S Poins l -

Select Connection Points

Device ID: -2141+L1-3,FL,11165
Device: KINT

Installation Pg.Line Symbol Connectior
Point

-2141 1.131 KINT 00 ...

KINTC 0
KINTC 0
KINTC 0
KINTC 0
KINTC 0

KINTC 0

I~10

Hfelp I
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6. Connect the new"KINTC" symbol to ICL flag "TFR" symbol by drawing a wire line
between them.

[

]
7. Connect ICL flag "TFR" symbol to loop flag "FIR" symbol by drawing a wire line

between them.
[

]
8. Connect loop flag "FIR" symbol to logic gate by adding a wire line.

[

I
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3.5.4.2 Edit Text

Text here refers to stand-alone text. To add text to the drawing, click Draw>text from the
menu bar, and the following window will show up. After setting up attribute value, click
OK.

l• .I.

F Language Text i

Number. [ Text Search..

Height

Angle:

jO.0750
I0

Sland:

Ratio: Io.9000

Label Origin: 15

Color F7

Select...

Select...I

Select...

Select..

Position X

Position Y: 120.7600
[T.7 -

116.5600

r- Object Default Settings

Font: Ir Disable Settings

0 K __Lncel Help

To edit text, right click the text on the drawing and then make changes in the editor window.

3.5.4.3 Edit Wire lines

Wire lines carry the signals from one symbol to the next. They are used to connect all logic
symbols, I/O symbols, ICL and DDB symbols within a loop or to and from the loop.

1. To add a wire line, click Draw>wire>continuous from the menu bar, and place the wire
line at the desired location in the schematic.

2. To modify a wire line, right click the wire line and select Modify Line, or click
Modify>Line from the menu bar, select the line and then right click. The following
window will show up with options to modify wire lines. The Wire option should always
be selected to connect logic symbols.
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Color 1

r Line Style ICONTINUOUS

..... ..• c l -CnUelp

NOTE

Drawing lines are used for non-logic related information
where no data is passed between the line connections.
Drawing lines are not used to connect logic symbols.

3. Select Line Style in the Modify Wire>Line window and click Select. The following
window will show up. Continuous wire lines are used in most cases. Dashed are used

to show digital signals on analog logic diagrams.

IS e - ~ Li . x~eI , I I E

- Line Type:

BYBLOCK
BYLAYER
CONTINUOUS
MITTE
RAND
GESTRICHELT
BORDER
CENTER

4qPfl IRF

W ~ 1help

3.5.4.4
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Edit Pane Variables

1. Select Manage>Page>Modify, the following dialog will show up. Each Parameter
button manages different page Variables.

Mo dfP e. Data

In J.11 1j::rn 13 _I _elcý ..C

Luc -,e 1 11

Format Name ID-KEPCOD ]
Select Page Format...

I- Online
SPage Tyvpe

l• ci,•>,r, -J1

r Title Block -Page Macro Parametersim m ,, - 1 1... 2..._ _ 3... 1 4... 1I ..._ .
Select... L I._.. ._J_. 10 ..._

C ancl BeI

2. Selecting Parameters I can access the dialog as shown to change current revision and
current date of the drawing.

.1, 1 E73x

Page Description 1

Date Drawn:

Date Checked

Drawn By:

Checked By

Date Revised

Revised By

Page Description 2

9. Para

10. Para

I1ý212.DEJ03-43

108/04/01

1
jHFC

ISCHEMATIC WIRING DIAGRA'

IREACTOR COOLANT PUMP 0

IPUMP RC-PP06A

I
IS-10079

1700305-25

Search Language Text... I
Cancel Eelp
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Section 4

promis-e REPORTS EXTRACTION

4.1 PRELIMINARY CONFIGURATION

Install HFC EWS/MCRT software suite and create a job for the control system being
developed. Refer to the EWS User's Guide and the MCRT User's Guide for installation and
configuration information.

4.2 GENERATION OF REPORT FILES

The following procedures describe how to generate One-Step report files using promis-e.

1. Set up system settings of features in reports by clicking Tools > System settings on the
menu bar of promis-e. Enable Filter, disable Sort, and select file output.

I Systern Settings I , . I I I ý I I I ;, 11 11 11 1 1 E31

Grid Settings I Default Settings Report Settings I Reports: Description Files I P6nte 4--.-

Filter - Sort-.......... ..- Output .-.- - ... .

- OFF 0' OFF LC Screen
C Printer

1 File
| Project

'" • C € ON [- Interactive

W Graphic Output

I OK I Can..[ Save Lielp

2. Click Tools > HFC Report on the menu bar, and the following dialog box will pop-up.
Select the type of reports to be generated and click OK.
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I - -, - ,, II I I I

W' Logic Reports

r CAD Report

CAD fReport --ComrpI,=,e F'roject

£ -" CAD Reporrt -- Aftivý.': dr j..inq ord'.

3. If CAD Report is selected in step 1, the ".txt" CAD report files will be generated and
saved under HFControls/OneStep/System#/CADDATA. CAD reports can be selected
for either the complete project or the current drawing only by selecting the appropriate
target.

F Logic Reports

rV CAD Report

Tt CAD Report --Complete Project

C CAD Report --Active drawing only

Cancel Io .1

When the dialog box below appears, select No.

J• ,toCA.. DelI

,//iN Save changes to T:\PR41\PROJECT'WORK\ 36.EC1\ 2.EC1\____ 1.dwg?

Yes FOI CNancel

4. If Logic Reports is selected in step 1, several dialog boxes will appear to permit
selection of specific options.

5. When the dialog box below pops up, select options as indicated. Make sure "Only
device ID's with part number" is NOT selected. Then click OK.
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Mast6r Paits List E3

Pioject: SYS_821

Iv Replace Language Text

Iv Replace Multi-Line Text (1

rV Only On-Line Selected Pages

F~l Device~ PDsWtart Number.

r IncludeTerminals

I OK Cance

Output File Name: Pmastlst
Language -

1. JEnglish

2.

1I -Help

6. Click OK for this dialog box to continue.

.5Fl4 . ,,-

- Master List:

imast.st
Imast.lst

Select:

Installation:

Location:

1 I 1_J
Ii::=:°CancelJ Help "o'

7. Setup options in the dialog as shown. Location is filtered to "LI" in the Connection

template.
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, I x: - 1 11 E

File Name IWIRELIST
Installation IS e r h .

Location I Search...

Comment I

File Name(s)
WIRELIST

Parameter...

Delete

w

r- Open Connections

Cancel Help

8. Setup dialog is shown. Click CANCEL.

1ee :Poet -Isalto d: .I Ix

- Project:

_qY.S_821
b"-('ý_6;4 -h
SYS_712
SYS 725S'YS_761

. -I
SYS_ 76-1

S Y .8 1 1 "

S, -3"..', 1..

- Installation:

0958
0962
0963
0964
1811 1
1822
1823
1824

1r .
Search... I

Help

9. After step 8, the logic reports - ".txt" files
HFControls/OneStep/System##.

will be generated in folder
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Section 5

ONE-STEP CODE GENERATION AND CONVERSION

5.1 PRELIMINARY OPERATION

Generate promis-e reports first before start using One-Step Software to produce application
codes.

5.2 START UP

1.Start the One-Step program by double clicking on the OneStep Editor icon in the
HFControls V2.50 folder as shown below.

J Ejie Edit View F'"
4- Back rl fl

JAddress ý V O]6Go

Alarm Point Editor
-" Alarm process

CQ4 Editor

".*Database Editor

DDBTrend
r-)Digital Group Editor

Digital States Editor

Eng Units Editor
• Equation Editor

Event Code Editor
EWS and ]CRT property editor
SGraphics Builder

ItHart editor
Install License key
10 Card Editor
1•o Simulation

7. JCRT Display
- Memory Editor

'P PIP Definition
RQ Editor

i•SOE Logger
VideoTrend Display

rVT & CRT Data Editor

Focation: C: F594 bytes [Q-My(,
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2. After the One-Step software is started, the following window will pop up. The first time
OneStep Editor is started, no loops are available in the Available Loops window.

File View Help

Available Loops: Selected Loops:

,Ready NUM

3. Click File>Reload or click the LD button on the menu bar to load loop numbers.

J-j mw *.q 1 ; L

File View Help

M

Available Loops: Selected Loops:

Ready - NUM
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4. After loading loop numbers, all loop numbers for the current job will appear in the
Available Loops window as shown below. The next time the One-Step Editor is started,
all loop numbers that have been loaded previously will already be displayed in the
Available Loops window.

File View Help

M

Available Loops: Selected Loops:

5Q.... S..I.O. 4 .... .!•.H.. ........ P.F_ . > J
5002SI10084 MOV LATCHED LOGICDEF DU
5003 S10084 MOV LATCHED LOGIC DEF >>
5004S10084 MOV LATCHED LOGIC DEF
5005$10084 MOV LATCHED LOGIC DEF
5004 S10084 MOV LATCHED LOGIC DEF
5007 S10084 MOV LATCHED LOGIC DEF <

5006 510084 MOV LATCHED LOGIC DEF
5009S10084 MOV LATCHED LOGIC DEF

5010810084 MOVLATCHED LOGIC DEF

mUn fl4nnn &AM. SATrI ,rr I nr~r nrr

Ready - NUM ,

5. Selecting any entry in the Available Loops window and clicking the ">" button copies
that entry to the Selected Loops window. Single loop and multiple loops can be selected
and processed at one time. Clicking the ">>" button will send all of the loops to the
Selected Loops window. Clicking the "<" or the "<<" button will deselect the selected
loops or all loops in the Selected Loops window.
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File View Help

I', M•

Available Loops: Selected Loops:

5002510084 MOVLATCHED LOGICDEF . f 5001 Sl0084 MOVLATCHED LOGICDEF
5004S10084 MOV LATCHED LOGIC DEF 5003510084 MOV LATCHED LOGIC DEF
5007 S10084 MOV LATCHED LOGIC DEF 5005 510084 MDV LATCHED LOGIC DEF
5008S10084 MOV LATCHED LOGIC DEF - J 5006S10084 MOVILATCHED LOGIC DEF
5009 S10084 MOV LATCHED LOGIC DEF
5010 510084 MOV LATCHED LOGIC DEF
5011 S10084 MOV LATCHED LOGIC DEF <
5012 S10084 MOV LATCHED LOGIC DEF
5013S10084 MOVLATCHEDLOGICDEF <<
5014S10084 MOV LATCHED LOGIC DEF A

Ready. l NUM ,

5.3 GENERATING MACRO CODE

If the application contains macro definitions, then the macros must be generated first before
any application code can be generated. The following steps describe the sequence for

generating macro code for one or more loop controllers or remote.

1. Select the macro to be built. Typically all macros will be selected.
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File View Help

M

Avalable Loops: Selected Loops:

5014S10084 MOV LATCHED LOGIC DEF >
5015S10084 MOV LATCHED LOGIC DEF --

5016S10084 MOV LATCHED LOGIC DEF

-u - -. ÷- LB,'

I- d

2. Use the right arrow button to move the macro(s) from the Available Loops window to

the Selected Loops window. Click File>Process macros or the "NI" button to start

compiling and generating code for the selected macro(s).

AMC-j rJ.,

File View Help

Available Loops: Selected Loops:

5007S10084 MOV LATCHED LOGIC DEF A T MACRO_701 S10084._MACROS MOV LATI ,. ,(j
5008S10084 MOVLATCHEDLOGICDEF - MACRO_702S10084 MACROS MOVLATI
5009S10084 MOV LATCHED LOGIC DEF >> MACR0_703 S10084_,MACROS MOVLATI
5O10S10084 MOV LATCHED LOGIC DEF.- i MACRO_704 S10084.IMACROS MOVLATL__
5011 S10084 MOV LATCHED LOGIC DEF MACRO_705 S10084_,MACROS MOVLATI
5012S10084 MOV LATCHED LOGIC DEF MACRO706 S10084 ,MACROS MOVLATI
5013S10084 MOVLATCHEDLOGICDEF M.J MACRO-07S10084-MACROS MOVLATI
5014S10084 MOV LATCHED LOGIC DEF MACRO708 S10084._MACROS MOV LATI
5015S10084 MOV LATCHED LOGIC DEF <<J MACRO-709 S10084.MACROC MOV LATI
5016S10084 MOVLATCHEDLOGICDEF .A 07ACRO710S10084..MACROS MOVLAT1,,

iiiinn I11 fIn idIII I IdflrtI

Rea dy N M
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5.4 GENERATING APPLICATION CODE

The following steps describe the sequence for generating program code for one or more loop
controllers or remote.

3. Select the loop number for the Application EPROM to be built. In this example, the loop
5004 has been selected.

File View Help

Available Loops: Selected Loops:

5001 S10084 MOV LATCHED LOGIC DEF . >
5002S10084 MOV LATCHED LOGICDEF
5003S10084 MOV LATCHED LOGIC DEF :

5005 S10084 MOV LATCHED LOGIC DEF
500SS10084 MOV LATCHED LOGIC DEF
5007510084 MOV LATCHED LOGIC DEF
5008 S10084 MOV LATCHED LOGIC DEF
5009S10084 MOVLATCHED LOGIC DEF
5010S10084 MOV LATCHED LOGIC DEF .

Ready ..... NUM

4. Use the right arrow button to move the LOOP from the Available Loops window to the
Selected Loops window. Click File>Process Selected Loops or the "P" button to start
compiling and generating application codes for the selected loop(s).
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File View Help

Available Loops: Selected Loops:

5001 S10084 MOVIATCHEDLOGICDEF ^ •~j 5004910084 MOVLATCHEDLOGICDEF (•=
5002 S10084 MOV LATCHED LOGIC DEF
5002 S10084 IMOV LATCHED LOGIC DEF 5041>8 MO ACEIOI E

5003 S10084 MOV LATCHED LOGIC DEF
5005 S10084 MOV LATCHED LOGIC DEF
5006 S10084 MOV LATCHED LOGIC DEF
5007S910084 MOV LATCHED LOGIC DEF
5008S10084 MOV LATCHED LOGIC DEF <
5009 S10084 MOV LATCHED LOGIC DEF
5010S10084 MOV LATCHED LOGIC DEF
5011 S10084 MOV LATCHED LOGIC DEF . J

CnK If' InflAnA hI1SI I £Tr*I girn i ne-inI rin

Ready NUM -

5. If processing is successful, go to output folders to look for the application code
generated. Make sure no error message exists in the error files. The application code
"Apps####.prm" can then be loaded into an EPROM for testing.

6. If any debug window pops up with error messages, use information in the debug window
as well as error files in the output folders to debug. For example, errors in the original
promis-e drawings can be a source of compiling failure. Refer to Appendix D for the
error lists of the error files.

5.5 CONVERTING GRAPHIC FILES

The following steps describe the sequence required to generate ".gra" graphic files from a

promis-e drawings file.

1. To convert CAD reports to graphic files, select the loop first, and then click on the button
"G" in menu bar.
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- . . -_] j

FUe View Help

M

Available Loops: Selected Loops:

5001 S10084 MOV LATCHED LOGIC DEF ^ 7 5004S10084 MOV LATCHED LOGIC DEF
5002S10084 MOVLATCHED LOGIC DEF
5003S10084 MOVLATCHED LOGIC DEF _ >>
5005$0084 MOV LATCHED LOGIC DEFJ
500 S10084 MOV LATCHED LOGIC DEF
5007 S10084 MOV LATCHED LOGIC DEF
5008 S10084 MOV LATCHED LOGIC DEF
5009S10084 MOV LATCHED LOGIC DEF
5010 S10084 MOVLATCHED LOGIC DEF
501lS10084 MOV LATCHED LOGIC DEF

uninri•fnnA II IllI A Trlirr%' i nrlr

Ready . .. . . . ........ N.JM-

2. After the converting is done, go to check the WINJCRT/gra folder to make sure that the
".gra" files are there.

UG004-000-04 5-8 Rev C



Section 6 WRITING PROGRAM CODE TO EPROM

Section 6

WRITING PROGRAM CODE TO EPROM

6.1 INTRODUCTION

This section describes the general procedures of writing application code generated by One-

Step software to EPROM. There are different brands of EPROM programmer devices or
chip writer. Refer to the vendor's publication of the specific device for detailed instructions.

This section uses Dataman EPROM programmer as an example.

6.2 START UP

1.[
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2. [

6.3 LOAD APPLICATION CODE
[

I
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6.4 PROGRAM EPROM[
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]
6.5

1
INSTALL EPROM
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16.

6.6
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TEST EPROM

17. Start Memory Editor software, and check Rem/Loop in order to select a loop. After the

loop numbers are loaded to the drop down menu, select the loop, for example "0111".

Then enter the memory address for the Application file header, "C000:0" in the address

box, select "Ascii" for display format, and click Read button. The application program
will be displayed. Verify the application file date "11/06/02", the loop number "0111"

and the revision number "D" in the file are correct.

DDB status Memory/DPM usage I Configuration/D.Bta structure

Memory/Database Edit Remote Status CPC/T CPIP staus
EdtF System Software -

C" MemoryAccess ReadAddress IC000:0 Sysem.2/6.3 f Rem/Loor
Remote 

No

C Reaimep atabase e Point Reset 1 pt QW Ij Processor
Category Ioata :j Reset all I W"

Data Format

" Pubic memory pointers Pointers-Rev.Sx ISANITY _ Rev.4 ISANITY J A ,

- COOO:0

I I / U b / U l l0
0 0 J ' L - U b 4 / 9 / U 2 I
I I @ I 0 I @ I

7 Up

!jn

Dirplay Length (bytes)

116

F Repeat

1`10.17, Deceber 13 Errors/Attempts 10/9284

Loop 0111 - Rem: 01 Link: 00 Station: 00
Write Read

Z o_ C ancl I Help

18. Start MCRT software to test the correctness of the control logic in the new EPROM
against schematic drawings. Refer to appropriate test procedures for detailed

instructions.
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Appendix D ONE-STEP ERROR REPORT FILES

E
]
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